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Applications

Agilent Cary 50/100/300/4000/5000/6000i instruments run using the
easy-to-use Agilent Cary WinUV software. The Cary WinUV software
consists of various applications, depending on the Cary package
ordered (refer to Table 1). A brief description of each application is
provided in Table 2. For detailed information about each application,
refer to Chapter 3.

Throughout this manual, UV Dissolution and UV Fiber Optic Dissolution users
should replace ‘Cary WinUV Software” with ‘UV Dissolution Software’ or ‘UV
Fiber Optic Dissolution Software’ respectively.
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Table 1. Applications included with each Cary WinUV software package

Package Applications

Analysis ADL Shell, Advanced Reads, Align, Concentration, GLP Administration, Kinetics,
Scan, Scanning Kinetics, Simple Reads, System Information, Validate

Bio ADL Shell, Advanced Reads, Align, Concentration, Enzyme Kinetics, GLP
Administration, Kinetics, RNA-DNA Estimation, Scan, Scanning Kinetics, Simple
Reads, System Information, Thermal (not for Cary 50), Validate

Color Color

Pharma ADL Shell, Advanced Reads, Align, Concentration, Enzyme Kinetics, GLP

UV Dissolution

UV Fiber Optic Dissolution

Administration (not for CFR systems), Kinetics, RNA-DNA Estimation, Scan,
Scanning Kinetics, Simple Reads, System Information, Thermal (not for Cary
50), Validate, Spectroscopy Configuration Manager (administrator use only),
Varian Spectroscopy Database Administrator (administrator use only)

ADL Shell, Advanced Reads, Align, Concentration, Enzyme Kinetics, GLP
Administration (not for CFR systems), Kinetics, Scan, Scanning Kinetics, Simple
Reads, System Information, UV Dissolution, Validate, Spectroscopy
Configuration Manager (administrator use only), Varian Spectroscopy Database
Administrator (administrator use only)

ADL Shell, Advanced Reads, Align, Concentration, Enzyme Kinetics, Kinetics,
GLP Administration (not for CFR systems), Scan, Scanning Kinetics, Simple
Reads, System Information, UV Fiber Optic Dissolution, Validate, Spectroscopy
Configuration Manager (administrator use only), Varian Spectroscopy Database
Administrator (administrator use only)
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Table 2. Descriptions of each Cary WinUV software application

Application Description Page

ADL Shell A pre-defined template for writing ADL programs. 22

Advanced Reads For collecting absorbance readings for multiple samples at single and 22
multi wavelengths (up to 6).

Align For aligning various instrument lamps and accessories. 22

Color For calculating color coordinates, determining color difference and 23
graphically displaying both.

Concentration For quantitative analysis. 24

Enzyme Kinetics For determining various parameters of enzyme activity at single and multi 24
wavelengths (up to 6).

GLP Administration For restricting operator access, password-protecting each application. 24

Kinetics For performing kinetics determinations at single and multi wavelengths 25
(up to 6).

RNA-DNA Estimation For collecting absorbance readings of nucleic acids. 25

Scan For running and view data collections. 26

Scanning Kinetics For performing kinetics determinations for a wavelength range. 26

Simple Reads For taking absorbance readings at a single and multi wavelength (up to 26
6).

Spectroscopy For administrators to set 21 CFR Part 11 security and access privileges in 26

Configuration Manager Pharma software.

System Information For recording your company and instrument details for use in reports, 27
and so on.

Thermal For temperature-based multicell measurements, typically DNA melts at 28
single and multi wavelengths (up to 6) (not for Cary 50).

UV Dissolution For performing tablet dissolution measurements (Cary 50 only). 28

UV Fiber Optic For monitoring tablet dissolution using fiber optics (Cary 50 only). 28

Dissolution

Validate For testing your instrument to ensure that it is working correctly. 29

Varian Spectroscopy Provides a database environment for storing and maintaining your data. 29

Database Administrator
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User documentation

You have been provided with the following documentation to help set
up and operate your Cary system:

= Installation Guides (Cary 50 only), with information on
unpacking the instrument, installing the interface card in the
computer and setting up the system.

= A hardware manual, with safety practices and hazards
information, instructions for installing and maintaining the
components of the Cary and troubleshooting information.

= This software manual, with instructions for installing the Cary
WinUV software, an overview of the software detailed ‘How To...’
procedures and software-related troubleshooting information.

= Extensive Help (provided with the Cary WinUV software)
containing context-sensitive Help, step-by-step instructions for
frequently performed analyses and instructions for using any
accessories you ordered. Refer to ‘Using the Help’ on Page 19.

Conventions

The following conventions are used throughout procedures in the
documentation:

=  Menus, menu items, buttons and check boxes have been typed in
bold. For example, ‘click OK’ and ‘From the Edit menu, choose
Copy’.

= ALL CAPITALS indicate keyboard commands. For example,
‘Press ENTER’ and ‘Press SHIFT+F3’.

A Note is used to give advice or information.

A Tip is used to give practical hints to help you achieve the best
possible performance from your instrument.
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This chapter assumes you have already set up the Cary instrument
and computer, including installing the instrument interface card in
the computer (if you supplied your own computer) and connecting
the instrument and/or computer to the power supply as described in
the appropriate Cary hardware documentation.

Computer requirements

Follow this recommended computer configuration for running Cary
WinUV software when buying a new computer:

= IBM compatible

= Intel® Pentium® IV processor (or later)
= Atleast 1GB RAM

= Atleast 10 GB free space on hard drive

= Video card supporting 800 x 600 pixel resolution, high color (16
bit) mode (or better)

=  Super VGA screen (or better)
=  20xCD drive
= 16 bit sound card

=  Windows® 101 key keyboard

Cary WinUV Software Manual 1
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12

Microsoft® or compatible mouse
RS232 serial port

One comm port if using the Agilent SPS 3 Sample Preparation
System in conjunction with the Internal Routine Sampler

Two comm ports if using the Agilent SPS 3 Sample Preparation
System in conjunction with the External Sipper accessory

Windows XP with Service Pack 3
Microsoft Internet Explorer version 6* or later

PCI slot for IEEE or Cary 50 PCI

* The Cary WinUV software uses functionality provided by Microsoft
Internet Explorer version 6.0. You do not need to use this as your
Web browser. If your company rules prevent the installation of
Internet Explorer version 6, you can use another browser, with some
loss in functionality.

Cary 50 only:

One spare computer power supply connector
Power supply rating of 220 W
One spare slot for the accessory cable connector

Room for a second connector from the PCI interface card
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Preparation

Before installing the Cary WinUV software, ensure that you have:

Preparation requirement Reference

Installed Microsoft Windows XP operating system with Windows operating system documentation.
Service Pack 3 and checked that all devices, for example,
sound card and CD drive, are working.

Installed Windows Internet Explorer version 6 or later. Documentation supplied with Internet Explorer.
Set the monitor screen resolution to at least 800 x 600 Windows operating system documentation.
pixels and the color quality to at least High Quality.

Logged on as an Administrator. Windows operating system documentation.
Read the Late Breaking News. Any Late Breaking News documents delivered

with the Cary WinUV software.

The Cary WinUV software will read Cary 0S/2 and DOS data files. However, if
you are upgrading to version 4.10 from Cary 0S/2 or DOS, contact your local
Agilent office, as a service call will be required.

If you are installing 21 CFR Part 11 software, refer to the:

= Cary WinUV Pharma Software Installation Instructions for 21 CFR Part
11 Environments, publication number 8510258100

= UV Dissolution/UV Fiber Optics Dissolution Software Installation
Instructions for 21 CFR Part 11 Environments, publication number
8510237400

21 CFR Part 11 software installation involves an administrator using the Agilent
Spectroscopy Configuration Manager (SCM) to set up access privileges, and so
on. In addition, SCM uses the Varian Spectroscopy Database Administration
(VSDA) program for storing files. Refer to the SCM and VSDA Help for
information about setting up 21 CFR Part 11 systems.
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New computer

To install the Cary WinUV software on a new computer:

1 Log on to the instrument computer with Administrator
privileges.

2 Insert the application software disk, select the preferred
language and click OK.

3 Follow the prompts on the screen until the ‘Select Destination
Location’ window appears. Confirm the directory in which you
would like to install the application. Alternatively, click Browse
to choose a different location. Click Next.

Agilent strongly recommends that the Cary WinUV folder and applications be
installed in the recommended C:\Program Files directory.

4 The ‘Folder Does Not Exist’ dialog box may appear. Click Yes to
create the folder.

5 Follow the prompts on the screen until the ‘Ready to Install’
window appears. Click Install.

During the installation of the .Net Framework and GPIB driver, the computer may
appear frozen and the ‘Cancel’ button is unavailable. This is correct. The
installation can take 3 to 5 minutes. Do not try to exit the installation during this
time.

14

6 If prompted to complete installation of Cary WinUV by restarting
your computer, select No, I will restart the computer later. Click
Finish.

7 ‘Software Registration’ will be displayed. Click Next.
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Ensure the software registration is completed by the User of the Cary UV-Vis-NIR
spectrophotometer. For further information, refer to the Agilent Software
Registration Instructions, publication number 8510256100.

8

Complete all the fields on the ‘Customer Details’ page. Click
Next.

The Product Key is found on the front of the Cary WinUV Software disk case that
was delivered with the instrument.

10

1

12

13
14
15
16
17
18

Complete all the fields on the ‘Product Details’ page. Click Next.

Complete all the fields on the ‘Work Environment Details’ page.
Click Register.

A dialog box appears stating ‘Your Agilent registration has been
successful’. If your computer is not connected to the Internet,
refer to the Agilent Software Registration Instructions,
publication number 8510256100 for more information.

‘Validate Setup Wizard’ will be displayed. Click Next to install
the Validate version 4.10 (build 467) patch.

Remove the application disk from the CD drive.

Insert the disk labeled Help.

A list of Help files to be installed will be displayed. Click OK.
Follow the instructions on the screen to install the Help.
When the status indicates ‘Finished’, click Close.

Remove the Help disk from the CD drive.
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At the end of the application software installation, you will need to turn off the
computer in order to install the computer-instrument interface card and to
complete the automatic detection and installation of the driver for the instrument
interface card. Refer to the Cary 50 Installation Instructions (publication number
8510185100) or the Cary 100/300/4000/5000/6000i Spectrophotometers
Hardware Manual (publication number 8510197200).

19 Once the card has been installed, turn on the computer. If using a
Cary 50, proceed to Step 20. If using a Cary
100/300/4000/5000/6000i, proceed to Step 25.

20 The instrument interface card should automatically be detected.
A ‘Found New Hardware Wizard’ dialog box will be displayed.

21 Select No, not this time and then click Next.

22 When prompted, select Install software automatically
(Recommended).

23 During installation of the hardware drivers for the Cary 50 PCI
card, a warning message will be displayed. Click Continue
Anyway.

24 Click Finish.

25 Select the System Information application from the Cary WinUV

folder on the Windows desktop. Enter the company details,
instrument type and serial number. Click OK.

26 Restart the computer to complete the installation of the
instrument interface card.
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Installation

If you are upgrading 21 CFR Part 11 software, refer to the:

= Cary WinUV Pharma Software Installation Instructions for 21 CFR Part
11 Environments, publication number 8510258100.

= UV Dissolution/UV Fiber Optics Dissolution Software Installation
Instructions for 21 CFR Part 11 Environments, publication number
8510237400.

To upgrade the Cary WinUV software:

1

Cary 50 only: Turn off the computer and disconnect the Cary 50
interface cable from the instrument.

Log on to the instrument computer with Administrator
privileges.
If upgrading Cary WinUV version 3.1 or earlier, proceed to Step

4. If upgrading Cary WinUV version 4.10 (build 464), proceed to
Step 6.

Click Start > Settings > Control Panel > Add/Remove
Programs.
Click NI-488.2.1.60 and then click Change/Remove and follow

the prompts. When prompted click Yes to remove all unused
components.

From the Windows toolbar, right-click on the System
Information icon and click Shut Down System Information.

Insert the application software disk, select the preferred
language and click OK.

Follow the prompts on the screen until the ‘Select Destination
Location’ window appears. Confirm the directory in which you
originally installed the application software. If required, click
Browse to navigate to the correct location. Click Next.

The ‘Folder Exists’ dialog box will be displayed. Click Yes.
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10 Follow the prompts on the screen until the ‘Ready to Install’
window appears. Click Install.

During installation of the Microsoft .Net Framework and GPIB driver, the
computer may appear frozen and the ‘Cancel’ button is unavailable. This is
correct. The installation can take 3 to 5 minutes. Do not try to exit the installation
during this time.

11 If prompted to complete installation of Cary WinUV by restarting
your computer, select No, I will restart the computer later. Click
Finish.

12 ‘Software Registration’ will be displayed. Click Next.

Ensure the software registration is completed by the User of the Cary UV-Vis-NIR
spectrophotometer. For further information, refer to the Agilent Software
Registration Instructions, publication number 8510256100.

13 Complete all the fields on the ‘Customer Details’ page. Click
Next.

The Product Key is found on the front of the Cary WinUV Software disk case that
was delivered with the instrument.

18

14 Complete all the fields on the ‘Product Details’ page. Click Next.

15 Complete all the fields on the ‘Work Environment Details’ page.
Click Register.

16 A dialog box appears stating ‘Your Agilent registration has been
successful’. If your computer is not connected to the Internet,
refer to the Agilent Software Registration Instructions,
publication number 8510256100 for more information.

17 ‘Validate Setup Wizard’ will be displayed. Click Next to install
the Validate version 4.10 (build 467) patch.

18 Remove the application disk from the CD drive.
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20
21

22
23
24

25

Installation

Insert the disk labeled Help.

A list of Help files to be installed will be displayed. Click OK.
Follow the instructions displayed on the screen to install the
Help.

When the status indicates ‘Finished’, click Close.

Remove the Help disk from the CD drive.

Select the System Information application from the Cary WinUV
folder on the Windows desktop; enter the Company details,
Instrument type and Instrument Serial number. Click OK.

If using a Cary 100/300/4000/5000/6000i, restart the computer to
complete the installation.

If using a Cary 50, turn off the computer and then connect the
Cary 50 interface cable to the instrument to complete the
upgrade.

Starting the software

To start the Cary WinUV software:

1

Click the Windows Start button then (All) Programs, Agilent
and Cary WinUV. Alternatively, double-click the Cary WinUV
folder on the desktop.

UV Dissolution/UV Fiber Optic Dissolution:

Click the Windows Start button, then (All) Programs, Agilent,
UV Dissolution or UV FO Dissolution. Alternatively, double-
click the UV Dissolution or UV FO Dissolution folder on the
desktop.

Select the desired application. Refer to Chapter 3 for information
about the available applications.

After the initial Cary flash screen appears, the application will open.

To familiarize yourself with the Cary WinUV software, browse the Help after
installing the software. See ‘Using the Help’ on Page 19.
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Software Overview

22

This chapter provides a brief introduction to the Cary WinUV
software and the individual applications to help you familiarize
yourself with its use. For more detailed information about the
applications and their settings, refer to the extensive Help (see Page
19 for information about using the Help).

ADL Shell

The Applications Development Language (ADL) is a built-in
spectroscopy language supplied with the Cary WinUV software. The
ADL Shell gives you a pre-defined template for writing ADL
programs. Rather than needing to write the code for basic functions
such as graphing and filing, the ADL Shell has a number of these
commands already implemented. In other words, you do not have to
design your own interface — you can use the ADL Shell to provide the
basic functionality and build on that.

Advanced Reads

Align

The Advanced Reads application can be used to read multiple
samples in a single run at a single or multi wavelength (up to 6). You
can use various accessories to take multiple sample solution and
aliquot readings in absorbance, percent transmittance, Abs*F or
percent reflectance mode, and find the mean.

The Align application is used to align the lamp(s) in the instrument
and various accessories. It enables you to set instrument parameters
such as the beam mode and wavelength. It also allows you to keep
track of operating hours by lamp type.

The ‘Lamps’ page of the Alignment window allows you to monitor the
energy of the lamp(s). Instrument parameters can be changed on the
‘Cary’ page.

Align can also be used to configure the Series 1 and Series II 6 x 6
and 8 x 6 cell changer (Cary 100/300), the cell changer for microcells
(Cary 50/100/300/4000/5000/60001), and the Series I and II Rear
Beam Attenuator (Cary 100/300/4000/5000/6000i).

Cary WinUV Software Manual



Color
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The Color application is used to measure and calculate the
transmitted or reflected color of samples. The following extensive
color calculations are supported:

Tristimulus

Chromaticity

CIE Lab

CIE LUV

Hunter Lab

Whiteness

Yellowness (ASTM E 313-00)

Tint (ASTM E 313-00)

Gardner Color (ASTM D 6166-97 and DIN EN1557)

Haze (ASTM D1003-61)

Choice of 21 illuminants, including 2 user-specified illuminants
Choice of 6 observers, including 2 user-specified observers
Calculation interval of 1, 5 or 10 nm

Thickness correction to calculate the color of the same sample in
varying thicknesses, rather than having to measure the samples

Graphical display of color spaces
Color difference calculations — Delta E, FMC-2, CMC and BFD

Color matching tolerance circle using DE Lab
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Concentration

The Concentration application is used to calibrate the system for
quantitative analysis. You can select from several fit types for your
calibration: linear, direct linear and quadratic. Based on the fit type,
the Concentration application will calculate the coefficients of the fit
equation and the correlation coefficient. Alternatively, you can define
your own equation for the calibration.

Enzyme Kinetics

The Enzyme Kinetics application uses Michaelis-Menten principles to
calculate the maximum rate (V,,,,) and substrate concentration that
gives half the maximum rate (K,,) of enzyme-catalyzed reactions.

Accurately obtaining V,,,. and K, requires you to perform numerous
Enzyme Kinetics runs at different substrate or inhibitor
concentrations to create a series of absorbance versus time curves.
The software determines the initial velocity (V,) of each curve, then
you enter the substrate and inhibitor concentrations for each cuvette.

The software uses the V), [S] and [I] values to plot traces
representing absorbance versus time curves with a common [S] or
[I]. It is from these graphs that the software determines V,,,, and K,,.

Enzyme kinetics measurements can be performed at single or multi
wavelengths (up to 6).

GLP Administration

The GLP Administration application is used to protect the system
from unauthorized use, enabling application-specific privileges to be
turned on or off by the system administrator.

If this application is operational, users will need to be registered,
have a user name and a valid password before they can access the
various privileges.
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GLP Administration is not present in UV Dissolution or UV Fiber Optic Dissolution
software. The Spectroscopy Configuration Manager included in that package is
used to provide good laboratory practice functions.

Kinetics

The Kinetics application is used to obtain absorbance versus time
data to enable you to determine the rate of reaction. Kinetics
measurements can be performed at single or multi wavelengths (up
to 6).

The Kinetics application allows:

= (Calculation of Zero Order, First Order and Second Order reaction
rates from absorbance versus time data.

=  Entry of activity factors for multiple cells.
= Overlay of the best-fit line on raw data.

= Auto or manual estimates for the first order and second order
Marquardt fitting.

RNA-DNA Estimation

The RNA-DNA Estimation application is used to calculate the
following parameters, used in determining the amount, type and
purity of nucleic acid samples:

= Absorbance of samples at selected wavelengths.

= A(260)/A(280) ratios with or without background correction at
320 nm.

= Absorbance ratios at your own nominated wavelengths with or
without background correction.

= Average ratio values for replicate samples.

= Protein and nucleic acid concentrations using Warburg Christian
coefficients.

= 260 nm Factor Parameters, A(260) * F.
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The Scan application enables you to set up and run wavelength
scans, with the collected scans displayed in the ‘Scan’ window.

Scanning Kinetics

The Scanning Kinetics application allows you to perform cyclic scans
across a wavelength or wavenumber range. From the resultant
absorbance versus wavelength data, an absorbance versus time
(kinetics) curve can be obtained for any wavelength in the range. The
kinetics curves can then be used to calculate Zero Order, First Order
and Second Order reaction rates.

You can choose an automatic or manual estimate for the First Order
and Second Order Marquardt fitting.

This application also enables you to correct samples for a baseline
during the scan. You can choose a 100%T baseline, or you can select
from other baseline options such as a zero baseline correction that
will apply both a 100%T and a 0%T baseline correction to your sample
scans.

Simple Reads

The Simple Reads application is used to perform quick absorbance
readings of samples at single wavelengths. To take a reading, click
‘Zero’ to zero the instrument and then click ‘Read’.

Simple Reads measurements can be performed at single or multi
wavelengths (up to 6).

Spectroscopy Configuration Manager

The Spectroscopy Configuration Manager (SCM) provides the system
administrator with a tool to manage your 21 CFR Part 11
environment. SCM provides the means to create, configure and
maintain data in relation to system security, user management and
data paths.
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The Privileges and Profiles software controls which
applications/functions may be run by a particular user. It also
establishes the level of authority a user may have with regard to
signatures and accessing certain parts of an application

Agilent uses the SCM for security and permission rights. These
security functions provide:

= Access controls and authority checks via the use of user
identification codes and passwords.

= Electronic record security via the use of databases.
= Time and date stamped audit trails.

The use of user identification codes and passwords enables control
over who can log on to the system and who can perform particular
functions within the Agilent application software. It also provides the
mechanism to allow electronic signing of electronic records. The use
of databases coupled with SCM, prevents all unauthorized users from
changing or deleting files. The SCM event logs augment the audit
trails resident in the application software. The SCM administrator
must set up the required users. It is important that a number of
simple requirements are followed when this is done to ensure that
compliance with the 21 CFR Part 11 rule is maintained.

System Information

The System Information application allows you to enter company
and instrument information, and specify headers, footers and bitmap
or icon files to be used in reports (for example, your company logo).

System Information also allows you to specify the default settings for
the ‘Hint’ text, such as the Hint Pause (the length of the delay before
the hint appears when the pointer is moved over a control) and Hint
Hide Pause (the time the hint stays visible for if the pointer is not
moved off the control). These settings will be used by the other Cary
WinUYV applications.
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Thermal (not for Cary 50)

The Thermal application is used to perform thermal DNA analysis,
enabling you to calculate T,, using the various thermoelectric Cary
accessories. Once the data is collected, you can choose to calculate
the T,, value by either the derivative or hyperchromicity methods.

Thermal measurements can be performed at single or multi
wavelengths (up to 6).

UV Dissolution (Cary 50 only)

The UV Dissolution application is used to monitor tablet dissolution,
using up to two dissolution baths. The application enables you to
collect data for up to 10,000 minutes (8 days) at defined time
intervals.

The data can be displayed as absorbance, percent dissolved versus
time or milligrams dissolved versus time. You can then calculate the
time taken to reach a series of nominated percent dissolved values
and/or calculate the percent dissolution of the tablets at given times.

UV Fiber Optic Dissolution (Cary 50 only)

The UV Fiber Optic Dissolution application is used to monitor tablet
dissolution, using up to two dissolution baths and fiber optics. The
application enables you to collect data for up to 10,000 minutes

(8 days) at defined time intervals.

The data can be displayed as absorbance, percent dissolved versus
time or milligrams dissolved versus time. You can then calculate the
time taken to reach a series of nominated percent dissolved values
and/or calculate the percent dissolution of the tablets at given times.
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Validate

The Validate application enables you to carry out a number of
performance tests to verify that the system is performing according
to specification. Included are the validation tests needed to satisfy
the requirements of the British Pharmacopoeia, European
Pharmacopoeia, US Pharmacopoeia and Therapeutic Goods
Association of Australia.

An optional Validation package is also available from Agilent,
providing detailed information on the functional specification and
development process of the Cary system. It also contains detailed
DQ/IQ/0Q documentation to assist your initial and on-going
validation activities.

Varian Spectroscopy Database Administrator

The Varian Spectroscopy Database Administrator (VSDA) is designed
for system administrators to set up and maintain the databases that
are used by the application software to store data. VSDA uses
Microsoft SQL Server 2005 for database operations.

Companies can use VSDA together with the Agilent Spectroscopy
Configuration Manager (SCM), the application software and their
own Standard Operating Practices to form a 21 CFR Part 11 capable
environment for controlling their Agilent instruments.

VSDA allows the data collected by Agilent instruments to be stored
locally (on the same computer as the application software), or
remotely in a Client/Server arrangement.

Configuration must be performed by the system administrator, or a
person with administration rights to run VSDA.

File name extensions

The various Cary WinUV software files, such as method files, report
files and graphic files are saved with a three-letter file name
extension that represents the type of file, and the application that
created the file.
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The file name extensions for each file type are:

File type File name extension
Methods .m**
Data d4*
Report T
Graph Template g
Settings .
Baseline c**
Batch b
ASCII .CSV
Rich Text Format 1tf
Cary 0S/2 .dat
Cary DOS data.
Grams .spc
ADL .adl

where ** equals the Cary WinUV application code, used to distinguish
between different applications. The application codes are:

Application

File name extension

Advanced Reads
Color
Concentration
Enzyme Kinetics
Fabric Protection
Kinetics
RNA-DNA

Scan

Scanning Kinetics
Simple Reads
Sunglasses
Thermal

UV Dissolution/UV Fiber Optic Dissolution
Validate

ab
el
Jen
ek
Jtp
kn

Jdn

*

Jsw
sk

sr

*

'sg
Jtm
Jdt

*

. Vo
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For example, a method file from the Concentration application would
have the file name extension ‘“*.mcn’.

Interface

A typical Cary WinUV software screen consists of a Menu line (‘A’ in
Figure 1), Instrument buttons (B), Command buttons (C), Toolbar
(D), Graph area (E), Report area (F) and Status line (G).

Scan [Methad:C:\...\bleaching of green food dye with kinetics curve, bsk]- Offline F'.__.l’ijgl
Fle Edit Wiew Commands Setup.. Graph Maths.., LIHDA

0.0000 ; 5tm$ . Stop ‘ 600.00

Abs rm

sew. ||ZhE X T+~ Da A B8 20 X B
: [ = w LIl
c A\
T B o
L
\-\-"“'m_
LS ———_
k s i'“'"“ L (] |
Crwaled Kirwbia s Traced - KInTrase_oor 54 _1 I
Offine G
Figure 1. A typical Cary WinUV software screen
A. Menu line B. Instrument buttons C. Command buttons D. Toolbar

E. Graph area F. Report area G. Status line
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Hint text

You can obtain ‘Hint text’ for a particular control or field by
positioning the pointer over the control/field name for a short time.
After a short delay, a brief hint will be displayed describing what the
control or field does. If you hold the pointer over a numeric entry
field, the valid range for that field will be displayed.

If these hints do not appear, choose ‘Hints’ from the ‘View’ menu to
enable them. Conversely, if the hint text is enabled and you wish to
turn it off, choose ‘Hints’ from the ‘View’ menu.

You can alter the properties of the hints, such as the length of the delay before
hints appear, on the ‘Hints" page in the System Information application.
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Using the Help

The Cary WinUV software includes extensive Help, which should be
your primary source of information on how to use your Cary system.
It contains descriptions of the various application windows, dialog
boxes and fields that make up the software, as well as step-by-step
instructions to help you perform various tasks. It also includes ‘Tips
and Tricks', ‘Troubleshooting' and ‘Contacts' sections in case you
encounter difficulties using the software.

Since the Help system is so extensive, it is advisable to familiarize
yourself with the contents of the Help by viewing the Help Home
page. There are a number of ways to open the Help Home page:

= Click the Windows ‘Start’ button, ‘(All) Programs’, ‘Agilent’, ‘Cary
WinUV’, ‘Cary Help’.

UV Dissolution/UV Fiber Optic Dissolution:
Click the Windows ‘Start’ button, then ‘(All) Programs’, ‘Agilent,
UV Dissolution’ or ‘UV FO Dissolution’.

= Double-click the ‘Cary WinUV’ folder on the desktop and double-
click ‘Cary Help'.
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UV Dissolution/UV Fiber Optic Dissolution:
Double-click the ‘UV Dissolution’ or ‘UV FO Dissolution’ folder on
the desktop and double-click ‘Cary Help’.

= Click ‘Help Topics’ on the ‘Help’ menu when in an application to
go to the Help Home page.

You can also make the Help open on the appropriate page containing
information relevant to the currently open application or dialog box:

= Click ‘(Application) Help’ (for example, ‘Scan Help’) on the ‘Help’
menu when in an application to go to the Home page for that
application.

=  Click the ‘Help’ button on a dialog box to go to information about
that dialog box.

= Press F1 to go to information about the current dialog box.

Navigating

You can move around the Help using the ‘Contents’ on the left of the
Help window.

To display the Contents, click the ‘Show’ button at the top of the Help window.

The Contents sections are accessed by clicking the icons and
associated text:

= To expand/contract a section in the Contents list, double-click
the ‘folder’ icon for that section, or click the ‘+’/‘-’ symbol next to
the icon.

= To display a topic, click the text associated with that topic.

The topics in the Help are often hyperlinked to other related
information. To return to the previous topic after clicking a
hyperlink, click the ‘Back’ button at the top of the Help window.
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Searching

You can quickly search the Help system for specific information
using key words.

To search for information on a particular subject:
1 Click the Search tab (next to the ‘Contents’ tab).

2 Type the word(s) you want to search for and click the List Topics
button or press ENTER to list all the relevant pages containing
the search word/s.

The number of topics found will be displayed. You can view the
topics in alphabetical order by clicking ‘Title’ at the top of the list, or
in the order they appear in the Help by clicking ‘Rank’.

3 Select the desired topic from the list by highlighting it then

clicking the Display button. Alternatively, double-click the topic.
All occurrences of the keyword will be highlighted.

4 If this does not provide the information you require, enter a more
specific word or additional words in the key words field and try
again. Click the right arrow symbol to the right of the keywords
field and select any of these words AND, OR, NEAR and NOT to
place between your keywords.

Another way to narrow your search is to use the check boxes at the bottom of
the Search page. For example, selecting ‘Search titles only” will only list those
Help topics containing the key word in the title.
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Within a page

You can skip to a section of interest in a Help page by searching for a
relevant word.

To find a key word within a Help page:
1 Click anywhere on the Help page.
2 Press CONTROL+F to open the ‘Find’ dialog box.

3 In the ‘Find what:’ field, enter the word you wish to look for.
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4 If required, limit the Find by selecting an option such as ‘Match
case’. (This option will only find the words that appear in the
same letter case (for example, all lower case) as the entered key
word.

b5 Select the Direction of the Find. Select ‘Up’ to search for the key
word from the bottom of the page upwards, or ‘Down’ to start the
Find from the top of a page.

6 Click the Find Next button or press ENTER to begin the Find.
The first occurrence of the designated word will be highlighted.

7 Click the Find Next button or press ENTER repeatedly to jump to
other occurrences of the key word. When all instances of the
word have been found, the message ‘Finished searching the
document’ will be displayed.

Tracking ‘favorite’ topics

You can keep a list of useful Help topics using the ‘Favorites’ option.

If you come across a topic you may wish to refer to again:

1 Click the Favorites tab. The title of the page currently visible will
be present in the ‘Current topic:’ field at the bottom of this tab.

2  Click the Add button to include this topic to the Favorites list.

If you would like to view this page later on, you can simply click the
‘Favorites’ tab and highlight the topic of interest by clicking it, then
click the ‘Display’ button. (Alternatively, double-click the topic.)

If a topic is no longer required in the Favorites list, highlight it then
click the ‘Remove’ button.

Printing

You can print one or more Help topics for a particular application.

To obtain a hard copy of the current Help page:

1 Click the Print button at the top of the Help window. The ‘Print’
dialog box will be displayed.

2 Click Print.
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To obtain a hard copy of multiple Help pages:
1 Right-click on the topic in the ‘Contents’ page, and choose Print.
2 Click Print the selected heading and all sub-topics.
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4. How To...

Start an application 38
Manually read samples using Advanced Reads 39

Perform a calibration and manually measure
concentrations using Concentration 42

Enzyme Kinetics 48

Kinetics 59
RNA-DNA Estimation73
Scan 82

Scanning Kinetics 99

Perform a Simple Reads measurement at a single
wavelength 110

Thermal m

Perform a UV Dissolution run (Cary 50) 124

Perform a UV Fiber Optic Dissolution run (Cary 50) 138
Set up tests for validation 150

This chapter provides step-by-step instructions on how to perform
common operating procedures using your Cary instrument and
various software applications. For more detailed information on the
software applications or your Cary instrument and accessories, refer
to the extensive Help (see Page 19 for information on using the Help).
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Start an application

1

For all Cary WinUV applications except UV Dissolution/UV
Fiber Optic Dissolution:

Click the Windows Start button, then (All) Programs, Agilent,
Cary WinUYV and click the application that you wish to run.
Alternatively, double-click the application icon in the ‘Cary
WinUV’ folder on the desktop.

For UV Dissolution/UV Fiber Optic Dissolution:

Click the Windows Start button, then (All) Programs, Agilent,
UV Dissolution or UV FO Dissolution and click the application
that you wish to run.

Select your instrument type if necessary and click OK to open the
application.

If you are running a GLP system, you will be prompted to enter a password
before accessing the application.

If you are using 21 CFR Part 11 software, you will be prompted to enter a user
identification, select the appropriate Group and Project and enter a password
before accessing the application.

38
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Manually read samples using Advanced Reads
This procedure describes how to read samples in the Advanced
Reads application using no accessories.

1 Set up data collection parameters
Setup dialog box

In Advanced Reads, click the Setup button or choose Setup from the
Menu line to display the ‘Setup’ dialog box and specify the method
parameters for a new method.

2 Set up instrument parameters

Setup dialog box | Cary page
a In the ‘Wavelength’ field, enter the relevant wavelength.

b In the ‘Ave. (averaging) Time’ field, enter the required value.
A good starting point is 0.1 seconds.

¢ In the ‘SBW’ field, enter the required spectral bandwidth.
Unless your method specified another value, use the
maximum setting. (Not for Cary 50.)

d Select ‘Replicates’ or ‘Sample Averaging’. For Replicates,
enter the number of replicates of each sample that you would
like read. For Sample Averaging, enter ‘2’ for duplicate
aliquots of the sample, and so on.

If using a microcell, select a smaller spectral bandwidth.

e Select the ordinate mode you require from the drop-down list
in the ‘Y Mode’ field. Enter a ‘Factor’ value if you have
selected ‘Abs*F’.

3 Setup lamp options
Setup dialog box | Options page
If you are using a Cary 50, proceed to Step 4.
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Select Auto lamps off to automatically turn off the lamps at
the end of the collect. This option is especially useful when
performing reads overnight or unattended for long periods of
time. In some Cary instrument models, you may also choose
to use a third lamp, such as a mercury lamp (if installed).

Click the UV/Vis button to use both lamps.

Enter the wavelength at which you would like the source
lamp to change from the ultraviolet to the visible/near-
infrared lamp. The recommended changeover is

350 nanometers for lamps with an ultraviolet cutoff.

If you are using a Cary 5000/6000i, also enter the detector
and grating changeover wavelengths (800 nanometers is
recommended for both).

Under ‘Beam Mode’, select the beam mode that you require.
In most cases this should be Double Beam and Normal. If
you select ‘Single Beam’ you also need to enter a value in the
‘Energy’ field.

4 Ensure no accessories are selected

Setup dialog box | Accessories pages

Make sure no accessories are selected on the ‘Accessories 1’ and
‘Accessories 2’ pages.

5 Set up your samples

Setup dialog box | Samples page

Enter the ‘Number of Samples’. The table below expands or
contracts to match your choice.

In the ‘Samples’ table, enter the name of each sample. You
can enter up to 20 characters for each name.

If the samples have the same name with a different numeric
extension, enter the name in the first sample position and
then click the ‘Increment’ button.

You can click the ‘Import’ button to use the names of samples
stored in a text file.
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6 Set up reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘AutoPrint’ to
automatically obtain a printout of your report. Select
‘Parameters’ to include your experimental parameters in the
report.

If ‘AutoPrint’ is selected, the system will send the report information to the
specified printer as well as the Report area. However if ‘AutoPrint’ is not
selected, the report will only be sent to the Report area.

7 Set up storage of collected data
Setup dialog box | Auto Store page

Select Storage off. The method, collected data and report will not be
automatically saved. However, you can manually save it all at the end
of the collection.

8 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.

9 Finish setup

Once you are satisfied with your method setup, click OK to confirm
any changes you have made and close the ‘Setup’ dialog box.

10 Zero the instrument

a Click Zero. Alternatively, choose Zero from the Commands
menu.

b Place a blank in the sample compartment and click OK.
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11 Read samples

a Click the Start button, press F9 or choose Start from the
Commands menu. The ‘Sample Selection’ dialog box will be
displayed.

b Select the samples you would like to read, then click OK.

¢ The ‘Present Sample’ dialog box will prompt you to place the
appropriate sample in the sample compartment. Click OK to
read the sample.

d Repeat for the remaining samples.
12 Save your data
a On the File menu, click Save Data As.
b  Enter the ‘File name’ for this Concentration run.
¢ Click Save. The data will be stored as a Batch file.
13 Export your data
On the File menu, click Export report (*.csv).
Enter the ‘File name’ for this read.

¢ Click Save. The data will be stored as an ASCII spreadsheet,
with a *.csv file name extension.

Perform a calibration and manually measure concentrations using
Concentration

42

This procedure describes how to perform a multi-standard
calibration and measure sample concentrations in the Concentration
application using no accessories.

1 Set up data collection parameters
Setup dialog box

In Concentration, click the Setup button or choose Setup from the
Menu line to display the ‘Setup’ dialog box and specify the method
parameters for a new method.

2 Set up instrument parameters

Setup dialog box | Cary page

a In the ‘Wavelength’ field, enter the relevant wavelength.
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In the ‘Ave. (averaging) Time’ field, enter the required value.
A good starting point is 0.1 second.

Enter the required spectral bandwidth in the ‘SBW’ field. Use
the maximum setting unless your method specifies another
value. (Not for Cary 50.)

If using a microcell, select a smaller spectral bandwidth.

Select ‘Replicates’ or ‘Sample Averaging’. For Replicates,
enter the number of replicates of each sample that you would
like read. For Sample Averaging, enter ‘2’ for duplicate
aliquots of the sample, and so on.

Select the ‘Y mode’ you require. Click ‘Abs’ to specify
Absorbance mode or ‘Emission’ if you are measuring
fluorescence. (Not for Cary 50.)

Enter an upper range and lower range value in the ‘Y min.’
and ‘Y max.’ fields to specify the displayed ordinate range.
These are starting values only. The Cary WinUV software will
automatically rescale the calibration graph as the standards
are measured.

3 Set up the calibration

Setup dialog box | Standards page

Click the Standards tab to set up the standards and their
parameters associated with the data collection.

Select Calibrate During Run to perform a calibration when
the ‘Start’ button is clicked.

Set the appropriate units for your standards for reporting
purposes.

Set the ‘Standards’ field to the number of standards that you
are using. The table below will expand or contract to match
your choice.

In the ‘Standards’ table, enter the concentration of each
standard in the ‘Conc.” column.

Under ‘Fit Type’, select the type of curve fitting required for
your calibration.
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Enter the required R? value or correlation coefficient in the
‘Min R? field. The closer the number is to 1.000, the better
the fit. Typically, 0.95 is used.

4 Setup lamp options

Setup dialog box | Options page

If you are using a Cary 50, proceed to Step 5.

Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of the collect. This option is especially
useful when performing Concentration runs overnight or
unattended for long periods of time.

Click the UV/Vis button to use both lamps.

Enter the wavelength at which you would like the source
lamp to change from the ultraviolet to the visible/near-
infrared lamp. The recommended changeover is

350 nanometers for lamps with an ultraviolet cutoff. If you
are using a Cary 5000/6000i, also enter the detector and
grating changeover wavelengths (800 nanometers is
recommended for both).

Under ‘Beam Mode’, select the beam mode that you require.
In most cases this should be Double Beam and Normal. If
you select ‘Single Beam’, you also need to enter a value in the
‘Energy’ field.

5 Ensure no accessories are selected

Setup dialog box | Accessories page

Click the Accessories tab and make sure that no accessories are
selected.

6 Setup your samples

Setup dialog box | Samples page

a4

Enter the number of samples in the ‘Number of Samples’
field. The table below expands or contracts to match your
choice.

In the ‘Samples’ table, enter the name of each sample. You
can enter up to 20 characters for each name.
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If the samples have the same name with a different numeric
extension, enter the name in the first sample position and
then click the ‘Increment’ button.

You can click the ‘Import’ button to use the names of samples
stored in a text file.

7 Setup reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.
b Enter a comment relating to your experiment in the
‘Comment’ field.
¢ Set up your report style by selecting the appropriate check

boxes under ‘Options’. For example, select ‘AutoPrint’ to
automatically obtain a printout of your report.

If ‘AutoPrint’ is selected, the system will send the report information to the
specified printer as well as the Report area. However, if ‘AutoPrint’ is not
selected, the report will only be sent to the Report area and can be viewed by
choosing ‘Report’ from the ‘View' menu.

8 Set up weight and volume correction

Setup dialog box | Samples page

a Under ‘Weight/Volume Corrections’, select Corrections to
activate the correction facility.

b Enter the theoretical sample weight in the ‘Method Weight’
field. This is the weight of the sample specified in your
method.

¢ Enter the weight units in the ‘Units’ field.

Enter the theoretical sample volume in the ‘Method Volume’
field. This is the volume to which the method tells you to
make the sample.

e Enter the volume units in the ‘Units’ field.

f In the ‘Samples’ table, enter the actual weight and volume for
each sample.
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9 Set up storage of collected data
Setup dialog box | Auto Store page

Select Storage off. The method, collected data and report will not be
automatically saved. However, you can manually save it all at the end
of the collection.

10 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.

11 Finish setup

Once you are satisfied with your method setup, click OK to confirm
any changes you have made and close the ‘Setup’ dialog box.

12 Zero the instrument

a Click Zero. Alternatively, from the Commands menu, choose
Zero.

b Place a blank in the sample compartment and click OK.
13 Perform the calibration

a Click the Start button or, from the Commands menu, choose
Start. The ‘Standard/Sample Selection’ dialog box will be
displayed.

b Select the standards and samples to be used in the analysis.
By default all standards and samples are selected.

¢ Click OK.

The ‘Present Standard’ dialog box will prompt you to place
the appropriate standard in the sample compartment. Click
OK to measure the standard.

e Repeat until you have measured all of the standards. The
Cary will calculate the calibration and the correlation
coefficient.
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If the set correlation coefficient (R2) value is not met, the Cary will prompt you
with ‘Min R? test failed’. When you click ‘0K’, the Cary will then prompt you with
‘There is no valid calibration. Proceed in Abs (or Emission)?’ If you click ‘Cancel’,
the Concentration run will finish. If you click ‘Yes’, the Cary will measure the
absorbance or emission of any presented samples, but will not generate a
concentration.

14 Measure sample concentration

a Once all the standards have been read, the ‘Present Sample’
dialog box will prompt you to place the appropriate sample
in the sample compartment. Click OK to measure the sample
and calculate its concentration. (If replicates have been
nominated, the concentration is calculated after the final
sample replicate is read.)

b Repeat for the remaining samples.
15 Save your data
a On the File menu, click Save Data As.
b Enter the ‘File name’ for this Concentration run.
¢ Click Save. The data will be stored as a Batch file.
16 Export your data
a On the File menu, click Export report (*.csv).
Enter the ‘File name’ for this read.

¢ Click Save. The data will be stored as an ASCII spreadsheet,
with a *.csv file name extension.

Cary WinUV Software Manual 47



How To...

Enzyme Kinetics
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The following Enzyme Kinetics procedures are described:
=  Performing a temperature-controlled run (Cary 50)

= Performing a temperature-controlled run using the Multicell
Holder (Cary 100-6000i)

Perform a temperature-controlled Enzyme Kinetics run (Cary 50)

This procedure describes how to perform a single cell, multi-rate
Enzyme Kinetics run at 37 °C using the single cell Peltier accessory
(Cary 50).

1 Setup data collection parameters
Setup dialog box

Click the Setup button or choose Setup from the Menu line to display
the ‘Setup’ dialog box and specify the method parameters for a new
method.

2 Ensure the Multicell Holder accessory is not selected
Setup dialog box | Accessories page

As various options do not become available until the appropriate
accessories are selected, you need to select these first.
Ensure ‘Use Cell Changer’ is not selected.

3 Setup accessories for reaction temperature control and
temperature display

a Under ‘Temperature’, select Automatic Temperature Setting
to enable the single cell Peltier accessory.

b  Set the monitoring temperature by entering the Block
temperature as 37 °C.

¢ Under ‘Temperature Display’, select Probes 1 and 2 to view
the temperature of two temperature probes in the ‘Status
Display’ window.
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4 Setup instrument parameters

Setup dialog box | Cary page

a Enter the ‘Wavelength’ and ‘Ave. (averaging) Time’ you
require in the corresponding fields.

b Enter an upper and lower range value in the ‘Y min.” and ‘Y
max.’ fields to specify the ordinate range.

5 Set up rate parameters

a Under ‘Collect Timing’, select Advanced Collect.

‘Advanced Collect’ enables you to collect data more frequently during the crucial
stages of your reaction, and to collect data less frequently where you know there
will be little activity.

b Enter the number of different reaction rates that you require
in the ‘Number of Stages’ field. The number you set here will
be reflected in the table below.

¢ Specify how long the Cary will wait after reading each cell
before it starts another reading cycle by setting the ‘Cycle
time’ for each rate stage.

d Specify the duration of the measurement run by setting the
‘Stop time’ for each rate stage.

6 Setup display options
Setup dialog box | Options page
Select ‘Individual Data’ to display the collected data of each sample

in individual graph boxes, or ‘Overlay Data’ to superimpose the
collected data of each sample in the run in one graph box.

7 Setup V, calculation
Setup dialog box | Analyze page
a Set the start and stop times for your V, calculation.

b Enter the correct product absorptivity and correct cell
pathlength for your reaction.
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8 Set up calculations for the maximum rate (V,,,,) and substrate
concentration that gives half the maximum rate (K,,)

Select the method by which the data obtained from your
selection under ‘Plot/Fit’ will be analyzed. Choose ‘Linear
Least Square’ or ‘Marquardt’.

Choose the inhibitor model for your analysis. Select ‘Non
Competitive’, ‘Competitive’ or ‘Uncompetitive’.

Select the Plot/Fit type/s that will be used to determine V,,,,.
and K,, values.

Select Auto Calculate to automatically perform Enzyme
Kinetics calculations on collected data at the end of each run.
These results will be displayed in the Report area.

9 Set up reporting and printing requirements

Setup dialog box | Reports page

a
b

Enter your name in the ‘Name’ field.

Enter a comment relating to your experiment in the
‘Comment’ field.

Set up your report style by selecting the appropriate items
under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the generated report.

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as to the Report area. However, if ‘Auto Print’ is not
selected, the report will only be sent to the Report area and can be viewed by
clicking ‘Report’ on the ‘View" menu.

50

Select the Autoconvert option you require. If you choose
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at
the end of the data collection, the system will automatically
generate a report and store the data in the Cary format as
well as ASCII XY pairs format in the current folder.
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10 Set up storage of collected data

Setup dialog box | Auto Store page

Select Storage On (Prompt at Start), to set the Cary to prompt you
for a file name before the start of an Enzyme Kinetics reaction.

11 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information on your current reaction.

12 Finish setup

Click OK to save any changes you have made and close the ‘Setup’
dialog box.

13 Zero the instrument

a Click the Zero button or choose Zero from the Commands
menu. A ‘Loading Guide’ will be displayed.

b If you like, change the names of the blank sample.

¢ Place the blank solution in the correct cell position and click
OK. The system will perform an instrument zero on the blank
solution.

14 Start the run

a Click the Start button or choose Start from the Commands
menu. Do not add your active reagent at this time. The
system will display a ‘Loading Guide’.

b Ifyou like, change the names of the sample.

¢ Place the sample solution in the correct cell position and
click OK. The system will set up the Graphics area and then
display the ‘Save As’ dialog box.

d Enter the ‘File name’ for this run and click Save. The ‘Sync
Start’ dialog box will be displayed.

e Add your active reagent just before the countdown reaches
0:00 or commence the data collection by clicking OK.

15 Enter substrate and inhibitor concentrations (two options)

Once the run has started:

a Open the ‘Setup’ dialog box by clicking the Setup button or
by choosing Setup from the Menu line.
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b Click the Samples tab. In the ‘S’ column, enter the Substrate
concentration in micromoles. In the ‘I’ column, enter the
Inhibitor concentration in micromoles.

If no information has been entered during the collect, no calculation is
performed.
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You can also use the ‘User Data Form’ to enter the Inhibitor and
Substrate concentrations:

a Open the ‘User Data Form’, by right-clicking in a graph box
and clicking User Data Form from the menu, or by choosing
User Data Form from the Graph menu.

b  The table that appears has Data Names and may have V,
values already entered in the first two columns. In the third
and fourth columns, enter your values for [S] and [I] in
micromoles per liter.

¢ Click OK. Your [S] and [I] values are now ready to be used in
calculations, and the Cary will perform the calculations at
the end of the run.

Perform a temperature-controlled Enzyme Kinetics run using the
Multicell Holder (Cary 100—6000i)

This procedure describes how to perform a multicell, multi-rate
Enzyme Kinetics run at 37 °C using the Temperature Controller

accessory with the Multicell Holder accessory (Cary
100/300/4000/5000/60001).

1 Setup data collection parameters
Setup dialog box

In Enzyme Kinetics, click the Setup button or select Setup from the
Menu line to display the ‘Setup’ dialog box and specify the method
parameters for a new method.
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2 Set up the Multicell Holder accessory
Setup dialog box | Accessories page
As various options do not become available until the appropriate
accessories are selected, you need to select these first.
a Select Use Cell Changer to enable the accessory.

b For Cary 100/300 instruments, choose the type of Multicell
Holder you are using (6 x 6 or 8 x 6). Ensure that you have
this accessory installed before starting the run.

If you are using a Series | 6 x 6 (Cary 100/300), you must calibrate the cell
changer using the Align application before starting experiments.

¢ Choose Select Cells and select the cells you require from the
available cells under ‘Use Cells’.

For Front Beam analysis, select ‘Cell 1-Cell 6’ (6 x 6) or ‘Cell 1-Cell 8’ (8 x 6).
This will ensure that all front cell positions in the Multicell Holder will be
measured during your enzyme kinetics analysis.

d Select Multi Zero to turn on the ‘Multi Zero’ facility.
e Ensure that Blank Correction is not selected.

3 Setup accessories for reaction temperature control and
temperature display

a Ifyou are not using a Peltier-controlled accessory (for
example, the water-thermostatted 8 x 6), ensure that you
have the Temperature Controller accessory installed before
starting the run, and,

(1) Select Automatic Temperature Setting and select
Temperature Controller to enable the accessory.

(ii) Set the monitoring temperature by entering the Block
temperature as 37 °C. (The monitoring device is selected in
Step 4d).
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b

Under ‘Temperature Display’, select Block and Probe 1 to
view the temperature of the Multicell Holder block and one
temperature probe in the ‘Status Display’ window.

4 Setup instrument parameters

Setup dialog box | Cary page

Enter the ‘Wavelength’, ‘SBW’ (spectral bandwidth) and ‘Ave.
(averaging) Time’ you require in the corresponding fields.

Select the ordinate mode you require. Click ‘Abs’ to specify
Absorbance mode or ‘%¥T’ to specify percent Transmittance.

The ‘%T" mode is used when performing fluorescence kinetics measurements
using the Total Fluorescence accessory or the Fluorescence Fiber Optic Probe.

Enter an upper range and lower range value in the ‘Y min.’
and ‘Y max.’ fields to specify the displayed ordinate range.

In the ‘Monitor’ field, choose where you are going to monitor
the temperature.

5 Set up rate parameters

Under ‘Collect Timing’, select Advanced Collect.

The ‘Advanced Collect’ facility enables you to collect data more frequently during
the crucial stages of your reaction, and to collect data less frequently where you
know there will be little activity.
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Enter the number of different reaction rates that you require
in the ‘Number of Stages’ field. The number you set here will
be reflected in the table below.

Vary the number of data points collected per cell per run by
setting the ‘Dwell time’ for each rate stage.

Specify how long the Cary will wait after reading each cell
before it starts another reading cycle, by setting the ‘Cycle
time’ for each rate stage.
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Specify the duration of the measurement by setting the ‘Stop
time’ for each rate stage.

6 Setup lamp and graphics options

Setup dialog box | Options page

Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This is especially useful
when performing data collections overnight or unattended
for long periods of time.

Click UV/Vis if you want both lamps on during the run.

Enter your required ‘Source Changeover’ and ‘Detector
Changeover’ (Cary 5000 only) wavelengths in the
corresponding fields. If you are using a Cary 5000/6000i, also
enter the detector and grating changeover wavelengths

(800 nanometers is recommended for both).

Set the ‘Slit Height’ to full or reduced (Cary 4000/5000/6000i
only).

Under ‘Display Options’, choose ‘Individual Data’ to display
the collected data of each sample in individual graph boxes.
Choose ‘Overlay Data’ to superimpose the collected data of
each sample in the Enzyme Kinetics run in one graph box.

7 Setup V, calculation

Setup dialog box | Analyze page

a
b

Set the start and stop times for your V, calculation.

Enter the required product absorptivity and cell pathlength
for your reaction.

8 Set up calculations for the maximum rate (V,,,,) and substrate
concentration that gives half the maximum rate (K,,)
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Under ‘Analyze’, select the method by which the data
obtained from your selection under ‘Plot/Fit’ will be
calculated. Choose ‘Linear Least Square’ or ‘Marquardt’.

Choose the inhibitor model for your analysis.

Select the Plot/Fit type/s that will be used to determine V,,,,.
and K,, values.

Select Auto Calculate to automatically perform enzyme
kinetics calculations at the end of each run.
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9 Set up reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate items
under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the generated report.

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as to the Report area.
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d Select the Autoconvert option you require. If you choose
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’,
the system will automatically generate a report and store the
data in the Cary format as well as ASCII XY pairs format in
the current folder.

10 Set up storage of collected data

Setup dialog box | Auto Store page

Select Storage On (Prompt at Start), to set up the Cary to prompt
you for a file name before the start of an Enzyme Kinetics reaction.
11 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.

12 Finish setup

Click OK to save any changes you have made and close the ‘Setup’

dialog box. Depending on the cells selected in the Multicell Holder,

the Cary may inform you that it will perform a dual single beam
calibration. Click OK.

13 Zero the instrument

a Click Zero or choose Zero from the Commands menu. A ‘Cell
Loading Guide’ will be displayed.
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b If you like, change the names of the blank samples.
¢ Place the blank solution(s) in the correct cell positions and

click OK. The system will perform an instrument zero on the
blank solution(s).

If you had chosen not to use the ‘Multi Zero’ facility in Step 2d, the system will
prompt you to enter the blank solution into the instrument. You must make sure
that you place the blank solution in the cell position that is currently in the light
path. Once you click ‘0OK’, the system will perform a zero on the cell position in
the light path, that is, the system will not reset the Multicell Holder to position 1.

14 Start the run

a Click Start or choose Start from the Commands menu. Do
not add your active reagent at this time. The system will
display a ‘Cell Loading Guide’.

b If you like, change the names of the samples.

¢ Place the sample solution(s) in the correct cell positions and
click OK. The system will set up the Graphics area and
display the ‘Save File’ dialog box.

d Enter the file name and click Save. The ‘Sync Start’ dialog
box will be displayed.

e Reset the Multicell Holder to position to cell 1 by clicking the
Reset Slide button. Add your active reagent just before the
countdown reaches 0:00, or commence the data collection by
clicking OK.

15 Enter substrate and inhibitor concentrations (two options)

Once the run has started:

a Open the ‘Setup’ dialog box by clicking the Setup button or
by choosing Setup from the Menu line.

b Click the Samples tab. In the ‘S’ column, enter the Substrate
concentration in micromoles. In the ‘I’ column, enter the
Inhibitor concentration in micromoles.
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If no information has been entered during the collect, no calculation is
performed.

You can also use the ‘User Data Form’ to enter the Inhibitor and
Substrate concentrations:

a Open the ‘User Data Form’, by right-clicking in a graph box
and clicking User Data Form from the menu, or by choosing
User Data Form from the Graph menu.

b  The table that appears has Data Names and may have V,
values already entered in the first two columns. In the third
and fourth columns, enter your values for [S] and [I] in
micromoles per liter.

¢ Click OK. Your [S] and [I] values are now ready to be used in
calculations, and the Cary will perform the calculations at
the end of the run.
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Kinetics
The following Kinetics procedures are described:
= Performing a temperature-controlled Kinetics run (Cary 50)

= Performing a temperature-controlled Kinetics run using the
Multicell Holder (Cary 100-6000i)

= Performing a multi-wavelength, single cell, single rate Kinetics
run (Cary 100-6000i).

Perform a temperature-controlled Kinetics run (Cary 50)
This procedure describes how to perform a single cell, multi-rate
Kinetics run at 37 °C using the single cell Peltier accessory (Cary 50).

1 Setup data collection parameters
Setup dialog box

In Kinetics, click the Setup button or choose Setup from the Menu
line to display the ‘Setup’ dialog box and specify the method
parameters for a new method.

2 Ensure the Multicell Holder accessory is not selected
Setup dialog box | Accessories page

As various options do not become available until the appropriate
accessories are selected, you need to select these first.
Ensure ‘Use Cell Changer’ is not selected.

3 Setup accessories for reaction temperature control and
temperature display

a Under ‘Temperature’, select Automatic Temperature Setting
to enable the single cell Peltier accessory.

b Set the monitoring temperature by entering the block
temperature as 37 °C.

¢ Under ‘Temperature Display’, select Probe 1 to view the
temperature of one temperature probe in the ‘Status Display’
window.
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4 Set up instrument parameters

Setup dialog box | Cary page
a In the ‘Wavelength’ field, enter the wavelengths that you
would like to monitor.
b Enter an upper range and lower range value in the ‘Y min.’
and ‘Y max.’ fields to specify the displayed ordinate range.
¢ Select the abscissa (X) mode you require. Click ‘Min.’ to time
in minutes or ‘Sec.’ to time in seconds.

5 Set up rate parameters

a Under ‘Collect Timing’, select Advanced Collect. This enables
you to set up different data collection procedures for the
multiple rates in your reaction.

‘Advanced Collect’ enables you to collect data more frequently during the crucial
stages of your kinetics reaction, and to collect data less frequently where you
know there will not be much activity.

b  Enter the number of different reaction rates that you require
in the ‘Number of Stages’ field. The number you set here will
be reflected in the table below.

¢ Set the ‘Cycle time’ for each rate stage to specify how long
the Cary will wait after reading each cell before it starts
another reading cycle.

d Set the ‘Stop time’ for each rate stage to specify the duration
of the measurement run.

6 Set up display options
Setup dialog box | Options page

Select ‘Individual Data’ to display a separate graph for each cell, or
‘Overlay Data’ to display all results in the one graph.

7 Set up analysis parameters

Setup dialog box | Analyze page

a Select Auto Calculate to automatically perform a rate
calculation on collected data at the end of each run.
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b Select Advanced Calculate to set up multiple reaction rate
calculations for the Kinetics run.

¢ Enter the number of different rate calculations that you
require in the ‘Number of Stages’ field. The number you set
here will be reflected in the table below.

d Set up the stage ‘Start’ and ‘Stop’ times and select the
reaction order for each of these reaction stages.

If you select a ‘first order’ or ‘second order’ Simple Calculate rate calculation,
you can use the ‘Manual Guess’ items to manually enter the parameters: A, Alnf
and Rate (k). It is presumed that you have a reasonable idea of the values for
these fit parameters, as they will be used as a first guess for the Marquardt non-
linear regression analysis.

If you do not choose ‘Manual Guess’ the Cary system will
automatically calculate the A,, Alnf and Rate values when the ‘Start’
button is clicked.

e Enter a value in the ‘Factor’ field to calculate enzyme
activity. This numerical multiplication factor is applied to the
absorbance.

f If you are performing a second order reaction, enter the
initial concentration of the substrate before reaction.

g Select Display Fit to automatically overlay the calculated
lines of best fit onto the plotted data.

8 Set up reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the generated report.
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If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as the Report area. However, if ‘Auto Print” is not
selected, the report will only be sent to the Report area and can be viewed by
choosing ‘Report” from the ‘View" menu.
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d Select Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

e Select the ‘Autoconvert’ option you require. If you select
‘ASCII’ or ‘ASCII with Log’, at the end of the data collection,
the system will automatically generate a report and store the
data in the Cary format as well as ASCII XY pairs format in
the current folder.

9 Set up storage of collected data

Setup dialog box | Auto Store page

Select Storage On (Prompt at Start) to set the Cary to prompt you
for a file name before the start of a Kinetics run.

10 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information on your current reaction.

11 Finish setup

Once you are satisfied with your method setup, click OK to confirm
any changes you have made and close the ‘Setup’ dialog box.

12 Zero the instrument

a Click Zero, or choose Zero from the Commands menu. A
‘Loading Guide’ will be displayed.

b If you like, change the name of the blank.

¢ Place the blank solution in the sample compartment and click
OK. The system will perform an instrument zero on the blank
solution.
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13 Start the run

a Click the Start button to start a data collection. Alternatively,
choose Start from the Commands menu. Do not add your
active reagent at this time. The system will display the ‘Save
As’ dialog box.

b Enter the ‘File name’ for this Kinetics run and click Save.
The system will display a ‘Loading Guide’.

If you like, change the name of the sample.

d Place the sample solution in the correct position and click
OK. The system will set up the Graphics area and then
display the ‘Sync Start’ dialog box.

e Add your active reagent just before the countdown reaches
0:00, or commence the data collection by clicking OK.

Perform a temperature-controlled Kinetics run using the Multicell
Holder (Cary 100-6000i)

This procedure describes how to perform a multicell, multi-rate
Kinetics run at 37 °C using the Temperature Controller accessory
with the Multicell Holder accessory (Cary 100/300/4000/5000/6000i).

1 Set up data collection parameters
Setup dialog box

Click the Setup button or choose Setup from the Menu line to display
the ‘Setup’ dialog box and specify the method parameters for a new
method.

2 Set up the Multicell Holder accessory
Setup dialog box | Accessories page

As various options do not become available until the appropriate
accessories are selected, you need to select these first.
a Select Use Cell Changer to enable the accessory.

For Cary 100/300 instruments, choose the type of Multicell
Holder you are using (6 x 6 or 8 x 6). Ensure that you have
this accessory installed before starting the run.

Cary WinUV Software Manual 63



How To...

If you are using a Series | 6 x 6 (Cary 100/300), you must calibrate the cell
changer using the Align application before starting experiments.

¢ Click Select Cells and select the cells you require from the
available cells under ‘Use Cells’.

For Front Beam analysis, select ‘Cell 1 to Cell 6’ (6 x 6) or
‘Cell 1 to Cell 8 (8 x 6). This will ensure that all front cell
positions in the Multicell Holder will be measured during
your Kinetics analysis.

d Select Multi Zero.
e Ensure ‘Blank Correction’ is not selected.

3 Setup accessories for reaction temperature control and
temperature display

a Ifyou are not using a Peltier-controlled accessory (for
example, the water-thermostatted 8 x 6), ensure that you
have the Temperature Controller accessory installed before
starting the run, and,

(i) Select Automatic Temperature Setting and select
Temperature Controller to enable the accessory.

(ii) Set the monitoring temperature by entering the Block
temperature as 37 °C. (The monitoring device is selected in
Step 4e).

b Under ‘Temperature Display’, select Block and Probe 1 to
turn on monitoring of the Multicell Holder block and one
temperature probe.

4 Set up instrument parameters

Setup dialog box | Cary page

a Enter the ‘Wavelength’, ‘SBW’ (spectral bandwidth) and ‘Ave.
(averaging) Time’ you require in the corresponding fields.

b  Select the ordinate mode you require. Click ‘Abs’ to specify
absorbance mode or ‘%T’ to specify percent transmittance.
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¢ Enter an upper range and lower range value in the ‘Y min.’
and ‘Y max.’ fields to specify the displayed ordinate range.

d Select ‘Min.’ or ‘Sec.’ to set the abscissa (X).

e In the ‘Monitor’ field, choose where you are going to monitor
the temperature. The ‘Start’ button will not be enabled until
the temperature of the selected monitor is within 0.5 °C of
the block temperature set on the ‘Accessories’ page (Step 3a
(ii)).

5 Set up rate parameters
a Under ‘Collect Timing’, select Advanced Collect. This enables

you to set up different data collection procedures for the
multiple rates in your reaction.

The ‘Advanced Collect’ facility enables you to collect data more frequently during
the crucial stages of your reaction, and to collect data less frequently where you
know there will be little activity.

b Enter the number of different reaction rates that you require
in the ‘Number of Stages’ field. The number you set here will
be reflected in the table below.

¢ Vary the number of data points collected per cell, per run, by
setting the ‘Dwell time’ for each rate stage.

d Specify how long the Cary will wait after reading each cell
before it starts another reading cycle by setting the ‘Cycle
time’ for each rate stage.

e Specify the duration of the Kinetics run by setting the ‘Stop
time’ for each rate stage.

6 Setup lamp and graphics options

Setup dialog box | Options page

a Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This is especially useful
when performing Kinetics data collections overnight or
unattended for long periods of time.

b Click the UV/Vis button if you want both of the lamps on
during the run.
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¢ Enter your required ‘Source Changeover’ and ‘Detector
Changeover’ (Cary 5000 only) wavelengths in the
corresponding fields. If you are using a Cary 5000/6000i, also
enter the detector and grating changeover wavelengths (800
nanometers is recommended for both).

d Set the ‘Slit Height’ to full or reduced (Cary 4000/5000/6000i
only).

e Under ‘Display Options’ choose ‘Individual Data’ to display
the collected data of each sample in individual graph boxes.
Choose ‘Overlay Data’ to superimpose the collected data of
each sample in the Kinetics run in one graph box.

7 Set up analysis parameters

Setup dialog box | Analyze page

a Select Auto Calculate to automatically perform a rate
calculation at the end of each run.

b Select Advanced Calculate to set up multiple rate
calculations for the Kinetics run.

¢ Enter the number of different rate calculations that you
require in the ‘Number of Stages’ field. The number you set
here will be reflected in the table below.

d Set up the stage ‘Start’ and ‘Stop’ times and select the
reaction order for each of these reaction stages.

If you select a “first order’ or ‘second order’ Simple Calculate rate calculation,
you can use the items under ‘Manual Guess’ to manually enter the parameters:
Ao, Alnf and Rate (k).

e Enter a value in the ‘Factor’ field to calculate enzyme
activity. This multiplication factor is applied to the
absorbance.

f If you are performing a second order reaction, enter the
initial concentration of substrate before reaction.

g Select Display Fit to automatically overlay the calculated
lines of best fit onto the plotted data.
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8 Set up reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘Auto Print’ to

automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the generated report.

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as to the Report area.

d Select Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

e Select the ‘Autoconvert’ option you require. If you select
‘ASCIT’ or ‘ASCII with Log’, at the end of the data collection,
the system will automatically generate a report and store the
data in the Cary format as well as ASCII XY pairs format in
the current folder.

9 Set up storage of collected data
Setup dialog box | Auto Store page
Select Storage On (Prompt at Start) to set the Cary to prompt you

for a file name, before the start of a Kinetics reaction.

10 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.

11 Finish setup

Click OK to save any changes you have made and close the ‘Setup’
dialog box.

12 Zero the instrument

a Click Zero or from the Commands menu, choose Zero. A
‘Cell Loading Guide’ will be displayed.
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b If you like, change the names of the blank samples.

¢ Place the blank solution(s) in the correct cell positions and
click OK. The system will perform an instrument zero on the
blank solution(s).

13 Start the run

a Click the Start button or from the Commands menu, choose
Start. Do not add your active reagent at this time. The
system will display the ‘Save As’ dialog box.

b Enter the ‘File name’ of this Kinetics run and click Save. The
system will display a ‘Cell Loading Guide’.

If you like, change the names of the samples.

d Place the sample solution(s) in the correct cell positions and
click OK. The system will set up the Graphics area and then
the ‘Sync Start’ dialog box will be displayed.

e Reset the Multicell Holder position to cell 1 by clicking the
Reset Slide button.

f Add your active reagent just before the countdown reaches
0:00, or commence the data collection by clicking OK.

Perform a multi-wavelength, single cell, single rate Kinetics run (Cary
100-6000i)

This procedure describes how to perform a multi-wavelength, single
cell Kinetics run at ambient temperature (Cary
100/300/4000/5000/6000i).

1 Set up data collection parameters
Setup dialog box

In Kinetics, click the Setup button or choose Setup from the Menu
line to display the ‘Setup’ dialog box and specify the method
parameters for a new method.

2 Set up instrument parameters

Setup dialog box | Cary page
a In the ‘Wavelength’ field, enter the relevant wavelengths.
b In the ‘SBW’ field, enter the required spectral bandwidth.
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In the ‘Ave. (averaging) Time’ field, enter the required value.

Select the ordinate mode you require. Click ‘Abs’ to specify
the absorbance mode or ‘%T’ to specify percent
transmittance.

Enter an upper range and lower range value in the ‘Y min.’
and ‘Y max.’ fields to specify the ordinate range.

Select ‘Min.” or ‘Sec.’ to set the abscissa (X).

3 Setup rate parameters

Under ‘Collect Timing’, select Simple Collect to set up a
single rate for your reaction.

Specify how long the Cary will wait after reading each cell
before it starts another reading cycle by setting the cycle
time.

Specify the duration of the Kinetics run by setting the stop
time.

4 Setup lamp and graphics options

Setup dialog box | Options page

Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This is especially useful
when performing Kinetics data collections overnight or
unattended for long periods of time.

Click the UV/Vis button if you want both lamps on during the
run.

Enter your required ‘Source Changeover’ and ‘Detector
Changeover’ (Cary 5000 only) wavelengths in the
corresponding fields. If you are using a Cary 5000/6000i, also
enter the detector and grating changeover wavelengths (800
nanometers is recommended for both).

Set the ‘Slit Height’ to full or reduced (Cary 4000/5000/6000i
only).

Under ‘Display Options’, select ‘Individual Data’ to display
the collected data of each sample in individual graph boxes.
Select ‘Overlay Data’ to superimpose the collected data of
each sample in the Kinetics run in one graph box.
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5 Set up accessories

Setup dialog box | Accessories page

Click the Accessories tab and ensure that no accessories are
selected.

6 Set up analysis parameters

Setup dialog box | Analyze page
a Select ‘Auto Calculate’ to automatically perform a rate
calculation at the end of each run. Or select ‘Simple
Calculate’ to perform one rate calculation for the entire
Kinetics run.

b Set up the reaction start and stop times and select the
reaction order.

¢ Ifyou select a ‘first order' or ‘second order' Simple Calculate
rate calculation, you can use the ‘Manual Guess’ items to
manually enter the parameters: A, AInf and Rate (k).

If you do not choose ‘Manual Guess’, the Cary system will automatically
calculate the values: Ao, Alnf and Rate when the ‘Start’ button is clicked.
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d Enter a value in the ‘Factor’ field to calculate enzyme
activity. This multiplication factor is applied to the
absorbance.

e Ifyou are performing a second order reaction, enter the
initial concentration of substrate before reaction.

f  Select Display Fit to automatically overlay the calculated
lines of best fit onto the plotted data.

7 Setup reporting and printing requirements
Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.
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¢ Setup your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the generated report.

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as the Report area.

d Select Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

e Select the autoconvert option you require. If you select
‘ASCII’ or ‘ASCII with Log’, at the end of the data collection,
the system will automatically generate a report and store the
data in the Cary format as well as ASCII XY pairs format in
the current folder.

8 Set up storage of collected data
Setup dialog box | Auto Store page

Select Storage Off. The method, collected data and report will not be
saved. Or, select ‘Storage On Prompt at Start’ to set the Cary to
prompt you for a file name before the start of a run; or ‘Storage On
Prompt at End’ to set the Cary to prompt you for a file name at the
end of a run.

9 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.

10 Finish setup

Once you are satisfied with your method setup, click OK to confirm
any changes you have made and close the ‘Setup’ dialog box.

11 Zero the instrument

a Click Zero. Alternatively, choose Zero from the Commands
menu. A ‘Loading Guide’ will be displayed.

b If you like, change the name of the blank.
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¢ Place the blank solution in the sample compartment and click
OK. The system will perform an instrument zero on the blank
solution(s).

12 Start the run

a Click the Start button, or choose Start from the Commands
menu. Do not add your active reagent at this time. The
system will display a ‘Loading Guide’.

b If you like, change the names of the sample.

¢ Place the sample solution in the front cell holder and click
OK. The system will set up the Graphics area and then
display the ‘Sync Start’ dialog box.

d Add your active reagent just before the countdown reaches
0:00, or commence the data collection by clicking OK. The
Cary will start the Kinetics data collection.

13 Save your data
a On the File menu, and click Save Data As.
b  Enter the ‘File name’ for this Kinetics run.
¢ Click Save. The data will be stored as a Batch file.
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RNA-DNA Estimation
The following RNA-DNA procedures are described:
=  Performing a run using the Multicell Holder (Cary 50)

=  Performing a temperature-controlled run using the Multicell
Holder (Cary 100-6000i)

Perform an RNA-DNA run using the Multicell Holder (Cary 50)
This procedure describes how to perform a multicell wavelength scan
with baseline correction, multi zero and multi baseline (Cary 50).

1 Setup data collection parameters
Setup dialog box

Click the Setup button or choose Setup from the Menu line to display
the ‘Setup’ dialog box and specify the method parameters for a new
method.

2 Set up instrument parameters

Setup dialog box | Cary and Baseline pages

a Enter the first and second wavelengths at which you would
like to measure your sample.

b If you require background correction, select Background
Correction and enter a background wavelength in the
corresponding field.

¢ Ifyou are performing a wavelength scan, select Scan
Samples. The ‘Display Options’ will be activated and the
‘Baseline’ page will be displayed.

d Enter a ‘Start’ and ‘Stop’ wavelength value and select a ‘Scan
Rate’.

e Under ‘Display Options’, select the way in which you want
the data displayed as it is collected.

Choose ‘Individual Data’ to display the collected data of each
sample in individual graph boxes. Choose ‘Overlay Data’ to
superimpose the collected data of each sample in the run in
one graph box.
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Click the Baseline tab and select Baseline correction.

To use a previously stored baseline, click the Baseline button
and browse for the appropriate file. Otherwise, you can
perform your baseline correction at the beginning of the run.

3 Set up Multicell Holder accessory

Setup dialog box | Accessories 1 page

c
d

Select Use Cell Changer to enable the accessory. Ensure that
you have this accessory installed before starting the run.

Click Select Cells and select the cells you require from the
available cells under ‘Use Cells’.

Select Multi Zero to turn on the ‘Multi Zero’ facility.
Select Multi Baseline to turn on the ‘Multi Baseline’ facility.

4 Setup your samples

Setup dialog box | Samples page

Enter the number of samples that you are going to use in the
‘Number of Samples’ field. The ‘Sample Names’ list below will
expand or contract to match your choice.

In the ‘Sample Names’ list, enter the name of each sample.
You can enter up to 20 characters for each name.

If the samples have the same name with a different numeric
extension, enter the name in the first sample position and
click the ‘Increment’ button.

Click the ‘Import’ button to use sample names stored in a text
file.

Clear the red tick in the first column for any samples that
you do not wish to analyze.

If you would like multiple readings of the same aliquot, select
Replicates and enter the number of replicates required in the
field that appears.

5 Set up analysis parameters

Setup dialog box | Analyze page

If you would like to calculate any Warburg Christian or 260 nm
Factor parameters, make your selections here.
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6 Set up reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. If you have
selected ‘Scan Samples’ on the ‘Cary’ page, select ‘Graph’ to
include a graph in the generated report.

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as to the Report area. However, if ‘Auto Print’ is not
selected, the report will only be sent to the Report area and can be viewed by
choosing ‘Report’ from the ‘View' menu.

d Select the ‘Autoconvert’ option you require. If you choose
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at
the end of the data collection the system will automatically
generate a report and store the data in the Cary format as
well as ASCII XY pairs format in the current folder.

7 Setup storage of collected data
Setup dialog box | Auto Store page

Select Storage On (Prompt at Start), to set the Cary to prompt you
for a file name before the start of the RNA-DNA run.

8 Set up visual system monitoring

Select Show Status Display on any of the Setup pages or choose

Status Display from the View menu to display information about
your current reaction.

9 Finish setup

Click OK to save any changes you have made and close the ‘Setup’
dialog box.
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10 Zero the instrument

a Click Zero or choose Zero from the Commands menu. A ‘Cell
Loading Guide’ will be displayed.

b Place the blank solution(s) in the correct cell positions and
click OK. The system will perform an instrument zero on the
blank solution(s).

If you have chosen not to use the ‘Multi Zero” facility in Step 3c, the system will
prompt you to enter one blank solution into the instrument. In this case, it is
important to ensure that you place this blank solution in the cell position that is
currently in the light path. On clicking ‘0K’, the system will perform a zero on the
cell position in the light path, that is, the system will not reset the Multicell
Holder to position 1.
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11 Collect baselines (if not using a stored baseline)

If you have selected to perform a baseline correction (Step 2f) and
are not using a stored baseline, take a baseline reading now by
following the steps below. Otherwise, proceed to Step 12.

a Click Baseline to collect a baseline for each cell. A ‘Cell
Loading Guide’ will be displayed.

b Load the blank/s as depicted.

¢ Click OK. On completion of the baseline collections, the word

‘baseline’ will be displayed in red above the ordinate
instrument status reading.

12 Start the run

a Click the Start button or choose Start from the Commands
menu to start a data collection. The system will display the
‘Save As’ dialog box.

b  Enter the ‘File name’ for this RNA-DNA run in the ‘File name’
field and click Save. The system will display a ‘Cell Loading
Guide’.

¢ Place the sample solution(s) in the correct cell positions and
click OK. The system will then begin reading the samples and
printing the results to the Report area.

Cary WinUV Software Manual



How To...

Perform a temperature-controlled RNA-DNA run using the Multicell
Holder (Cary 100-6000i)

This procedure describes how to perform a multicell RNA-DNA run
with multi zero and multi baseline at 37 °C using the Temperature

Controller accessory with the Multicell Holder accessory (Cary
100/300/4000/5000/60001).

1 Set up data collection parameters
Setup dialog box

In RNA-DNA, click the Setup button or choose Setup from the Menu
line to display the ‘Setup’ dialog box and specify the method
parameters for a new method.

2 Set up the Multicell Holder accessory
Setup dialog box | Accessories 1 page
As various options do not become available until the appropriate
accessories are selected, you need to select these first.
a Select Use Cell Changer to enable the accessory.

b For Cary 100/300 instruments, choose the type of Multicell
Holder you are using (6 x 6 or 8 x 6). Ensure that you have
this accessory installed before starting the run.

If you are using a Series | 6 x 6 (Cary 100/300), you must calibrate the cell
changer using the Align application before starting experiments.

¢ Click Select Cells and select the cells you require under ‘Use
Cells’. For double beam analysis, select ‘Cell 1 through to the
Cell 6’ (6 x 6) or ‘Cell 1 through to Cell 8’ (8 x 6).

d Select Multi Zero.

The ‘Multi Baseline’ facility will not be accessible until completing
Step 4.
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3 Setup accessories for reaction temperature control and
temperature display

If you are not using a Peltier-controlled accessory (for
example, the water-thermostatted 8 x 6), ensure that you
have the Temperature Controller accessory installed before
starting the run, and,

(i) Select Automatic Temperature Setting and select
Temperature Controller to enable the accessory.

(ii) Set the monitoring temperature by entering the block
temperature as 37 °C. (The monitoring device is selected in
Step 4).

Under ‘Temperature Display’, select Block and Probe 1 to
view the temperature of the Multicell Holder block and one
temperature probe in the ‘Status Display’ window.

4 Setup instrument parameters

Setup dialog box | Cary and Baseline pages
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Enter the first and second wavelengths at which you would
like to measure your sample/s.

If required, select Background Correction and enter a
background wavelength in the corresponding field.

Choose the desired temperature monitoring device in the
‘Monitor’ field. The ‘Start’ button will not be enabled until the
temperature of the selected Monitor is within 0.5 °C of the
Block temperature set on the ‘Accessories 1’ page (Step 3a
(ii)).

To perform a wavelength scan, select Scan Samples and set
the ‘Start’, ‘Stop’ and ‘Rate’ for the scan. The ‘Baseline’ tab
will be displayed.

Click the Baseline tab.

Select Baseline correction. To use a previously stored
baseline, click the ‘Baseline’ button and browse for the
appropriate file. Otherwise, you can perform your baseline
correction at the beginning of the run. To perform a ‘Multi
Baseline’, you can now go back to the ‘Accessories 1’ page
and select ‘Multi Baseline’.
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5 Setup source, SBW and display options

Setup dialog box | Options page

Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This is especially useful
when performing data collections overnight or unattended
for long periods of time.

Click UV/Vis if you want both lamps on during the run.

Enter your required ‘Source Changeover’ and ‘Detector
Changeover’ (Cary 5000 only) wavelengths in the
corresponding fields. If you are using a Cary 5000/6000i, also
enter the detector and grating changeover wavelengths (800
nanometers is recommended for both).

Enter the spectral bandwidth of your instrument in the ‘SBW’
field.

Set the appropriate ‘Slit Height’ (Cary 4000/5000/6000i only).

Under ‘Display Options’, select ‘Individual Data’ to display

the collected data of each sample in individual graph boxes.
Choose ‘Overlay Data’ to superimpose the collected data of
each sample in the run in one graph box.

6 Setup your samples

Setup dialog box | Samples page

Enter the number of samples that you are going to use in the
‘Number of Samples’ field. The ‘Sample Names’ list below will
expand or contract to match your choice.

In the ‘Sample Names’ list, enter the name of each sample.
You can enter up to 20 characters for each name.

If the samples have the same name with a different numeric
extension, enter the name in the first sample position and
then click the ‘Increment’ button.

Click the ‘Import Names’ button to use names from a stored
text file.
Clear the red tick for any samples not required.

If you would like multiple readings of the same aliquot, select
Replicates and enter the number of replicates required.
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7 Set up analysis parameters

Setup dialog box | Analyze page

If you would like to calculate any Warburg Christian coefficients or
260 nm Factor parameters, make your selections here.

8 Set up reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. If you have
selected ‘Scan Samples’ on the ‘Cary’ page, select ‘Graph’ to
include a graph in the generated report.

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as to the Report area.

d Select the ‘Autoconvert’ option you require. If you choose
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at
the end of the data collection, the system will automatically
generate a report and store the data in the Cary format as
well as ASCII XY pairs format in the current folder.

9 Set up storage of collected data
Setup dialog box | Auto Store page

Select Storage On (Prompt at Start), to set the Cary to prompt you
for a file name before the start of the RNA-DNA run.

Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.

Cary WinUV Software Manual



How To...

10 Finish setup

Click OK to save any changes you have made and close the ‘Setup’
dialog box.

11 Zero the instrument

a Click Zero or choose Zero from the Commands menu. A ‘Cell
Loading Guide’ will be displayed.
b Place the blank solution(s) in the correct cell positions and

click OK. The system will perform an instrument zero on the
blank solution(s).

If you have chosen not to use the ‘Multi Zero' facility in Step 2d, the system will
prompt you to enter one blank solution into the instrument. In this case, it is
important to ensure that you place this blank solution in the cell position that is
currently in the light path. On clicking ‘OK’, the system will perform a zero on the
cell position in the light path, that is, the system will not reset the Multicell
Holder to position 1.

12 Perform a baseline correction (if not using a stored baseline)

If you have selected to perform a baseline correction (Step 4f) and
are not using a stored baseline, take a baseline reading now by
following the steps below. Otherwise, proceed to Step 13.

a Click Baseline. A ‘Cell Loading Guide’ will be displayed.
b Load the blank/s as shown.

¢ Click OK. The system will collect a baseline for each cell in
use and the word ‘baseline’ will be displayed above the
ordinate instrument status reading.

13 Start the run

a Click the Start button to start a data collection. Alternatively
you can choose Start from the Commands menu. The ‘Save
As’ dialog box will be displayed.

b Enter the ‘File name’ for this RNA-DNA run and click Save.
The system will display a ‘Cell Loading Guide’.
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Scan

¢ Place the sample solution(s) in the correct cell positions and
click OK. The system will then begin reading the samples and
printing the results to the Report area.

The following Scan procedures are described.

=  Performing a scan with baseline correction (Cary 50)

=  Performing a scan with baseline correction (Cary 100-6000i)
= Performing a scan in Signal-to-Noise mode (Cary 100-6000i)
= Performing a scan in Independent mode (Cary 5000/60001)

Perform a scan with baseline correction (Cary 50)
This procedure describes how to perform a wavelength scan from
800 nm to 200 nm with baseline correction using a Cary 50.

1 Set up data collection parameters
Setup dialog box

In Scan, click Setup or choose Setup from the Menu line to display
the ‘Setup’ dialog box and specify the method parameters for a new
method.

2 Set up instrument parameters

Setup dialog box | Cary page

a Set the wavelength range for the scan by entering the values
you require in the ‘Start’ and ‘Stop’ fields.

b In the ‘Y Mode’ field, select the ordinate mode in which you
want the collect data to be displayed.

¢ Enter an upper and lower range value in the ‘Y min.” and ‘Y
max.’ fields to specify the displayed ordinate range.

d Make sure that ‘Cycle Mode’ is not selected.

e Set the ‘Beam Mode’ for the run. This should be set to Dual
Beam.
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f  Under ‘Scan Controls’, select Simple and click a scan speed
button. Alternatively, you can select ‘Advanced’ and enter an
‘Ave. Time’ and ‘Data Interval’ (the Cary will then select the
Scan Speed).

g Under ‘Display Options’, select the way in which you want
the data displayed as it is collected. Choose ‘Individual Data’
to display the collected data of each sample in individual
graph boxes. Choose ‘Overlay Data’ to superimpose the
collected data of each sample in the Scan run in one graph
box.

3 Set up the baseline correction
Setup dialog box | Baseline page

Select Baseline Correction. This will force the Cary to perform a
baseline correction on the sample data. The correction will be
performed on each point before it is displayed.

You can use a stored baseline. To do this, click ‘Baseline” and open the saved
*.csw baseline file.

4 Ensure no accessories are selected
Setup dialog box | Accessories 1 page

Make sure that no options are selected on this page and that no
accessories are installed.

Setup dialog box | Accessories 2 page

Make sure that no options are selected on this page and that no
accessories are installed.

5 Setup reporting and printing requirements
Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.
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¢ Setup your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘AutoPrint’ to
automatically obtain a printout of your report. Select
‘Parameters’ to include your method parameters in the
report. Select ‘Graph’ to include a graph in the generated
report.

If ‘AutoPrint’ is selected, the system will send the report information to the
specified printer as well as the Report area. However, if ‘AutoPrint’ is not
selected, the report will only be sent to the Report area and can be viewed by
choosing ‘Report’ from the ‘View' menu.

d Setup the ‘Peak Table’ reporting.
(1) Select Peak Labels.

(ii) Click the Peak Information button and choose the type of
‘Peak Labels’, the ‘Peak Style’ and set the ‘Peak Threshold’.
Click OK.

(iii) Select Maximum Peak to report the peak with the largest
peak threshold that exceeds the Peak Threshold value.

(iv) Select All Peaks to report all peaks meeting the Peak
Style criterion and exceeding the Threshold value.

e Setup ‘X-Y pairs’ reporting, if required. You can use the
actual Data Interval by which the data was collected or you
can make the Cary interpolate the points to a new Interval.

f  Select the ‘Autoconvert’ option you require. If you select
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at
the end of the data collection the system will automatically
generate a report and store the data in the Cary format as
well as ASCII XY pairs format in the current folder.

6 Set up storage of collected data
Setup dialog box | Auto Store page

Select Storage On (Prompt at Start).
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7 Set up visual system monitoring

Select Show Status Display on any Setup page or from the View
menu to display information about your current reaction.

8 Finish setup

Once you are satisfied with your method setup, click OK to confirm
any changes you have made and close the ‘Setup’ dialog box.

9 Zero the instrument

Click Zero or choose Zero from the Commands menu to zero the
system.

10 Measure a baseline

a Click Baseline or choose Baseline from the Commands
menu.

b When prompted, insert the blank sample into the sample
compartment front beam and click OK.

The Cary will collect the baseline scan. After the collection, the word
‘baseline’ will be displayed in red in the ordinate status box,
indicating that you are in baseline correction mode and you have a
valid baseline file for the correction.

If the word 'baseline’ is gray and in italics, the baseline file is still valid. The gray
and italics indicate that the Cary is idling outside the abscissa range of the
baseline file.

11 Start the run

Click the Start button to start a data collection. Alternatively, you
can choose Start from the Commands menu.

12 Specify a file name for the data and sample names

a When you click Start, the ‘Save As’ dialog box will be
displayed. Enter the appropriate name for your Scan run and
click Save.
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b The ‘Sample Name’ dialog box will be displayed. Enter the
appropriate name for your sample and click OK. The Scan
run will commence and the corrected trace will be displayed
in the Graphics area. At the end of the run, the Cary will
create the report and also print it if ‘AutoPrint’ was selected
on the ‘Reports’ page of the ‘Setup’ dialog box.

Perform a scan with baseline correction (Cary 100-6000i)

This procedure describes how to perform a wavelength scan from
800 nm to 200 nm with baseline correction (Cary
100/300/4000/5000/6000i).

1 Setup data collection parameters
Setup dialog box

In Scan, click the Setup button or choose Setup from the Menu line
to display the ‘Setup’ dialog box and specify the method parameters
for a new method.

2 Set up instrument parameters
Setup dialog box | Cary page
a Set the appropriate abscissa mode in the ‘X Mode’ field.

b Set the wavelength range by entering the values you require
in the ‘Start’/‘Stop’ fields.

In the ‘Y Mode’ field, select the ordinate mode.

d Enter an upper and lower range in the ‘Y min.” and ‘Y max.’
fields to specify the displayed ordinate range.

9’

e Set the speed of the data collection by setting the ‘Ave. Time
and ‘Data Interval’. The Data Interval is the wavelength
increment between data points. The ‘Scan Rate’ will
automatically update when selected.

f  Make sure ‘Cycle Mode’ is not selected.
3 Setup SBW, lamp and graphics options
Setup dialog box | Options page
a Set the ‘SBW’ (spectral bandwidth).
b Set the ‘Beam Mode’ for the run (usually ‘Double’).
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¢ For Cary 5000/6000i, the fixed SBW is used to automatically
alter the Energy level and maintain a constant signal level.

d For Cary 4000/5000/6000i, set the ‘Slit Height’ to Full.

e Click the UV/Vis button if you want both lamps on during the
run.

f  Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This is especially useful
when performing Scan runs overnight, or unattended for long
periods of time.

g Do not select ‘Signal-to-Noise Mode’.

Under ‘Display Options’, select ‘Individual Data’ to display

the collected data of each sample in individual graph boxes.
Choose ‘Overlay Data’ to superimpose the collected data of

each sample in the Scan run in one graph box.

Setup dialog box | Independent page

If you are using a Cary 5000/6000i, do not change any options on the
‘Independent’ page.

4 Set up the baseline correction
Setup dialog box | Baseline page
Select Baseline Correction to perform a baseline correction on each

sample data point.

You can use a stored baseline by clicking ‘Baseline’ and opening the saved *.csw
baseline file.

5 Ensure no accessories are selected
Setup dialog box | Accessories 1 page

Make sure that no options are selected on this page and that no
accessories are installed.

Setup dialog box | Accessories 2 page

Make sure that no options are selected on this page and that no
accessories are installed.
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Setup dialog box | Accessories 3 page

Make sure that no options are selected on this page and that no
accessories are installed.

6 Set up reporting and printing requirements

Setup dialog box | Reports page

a
b

Enter your name in the ‘Name’ field.

Enter a comment relating to your sample in the ‘Comment’
field.

Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘AutoPrint’ to
automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the printed report.

If ‘AutoPrint’ is selected, the system will send the report information to the
specified printer as well as the Report area.

d

Set up the ‘Peak Table’ reporting.
(i) Select Peak Labels.

(ii) Click the Peak Information button and choose the ‘Peak

Type’, the ‘Labels Type’, and set the ‘Peak Threshold’. Click
OK.

(iii) Select Maximum Peak to report the peak with the largest
peak threshold that exceeds the Peak Threshold value.

(iv) Select All Peaks to report all peaks meeting the Peak
Style criterion and exceeding the Threshold value.

Set up ‘X-Y pairs’ reporting, if required. You can use the
actual Data Interval by which the data was collected, or you
can make the Cary interpolate the points to a new Interval.

Select the ‘Autoconvert’ option you require. If you select
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at
the end of the data collection the system will automatically
generate a report and store the data in the Cary format as
well as ASCII XY pairs format in the current folder.
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7 Set up storage of collected data

Setup dialog box | Auto Store page

Select Storage On (Prompt at Start).

Set up visual system monitoring

Select Show Status Display on any Setup page, or from the View
menu, to display information about your current reaction.

8 Finish setup

Once you are satisfied with your method setup, click OK to confirm
any changes you have made and close the ‘Setup’ dialog box.

9 Zero the instrument

Click Zero or choose Zero from the Commands menu to perform a
Zero.

10 Measure a baseline

a Click Baseline or choose Baseline from the Commands
menu.

b When prompted, insert the blank sample into the sample
compartment front beam and click OK. After the baseline is
collected, the word ‘baseline’ will be displayed in red in the
ordinate status box, indicating that you are in baseline
correction mode and have a valid baseline file for the
correction.

If the word ‘baseline’ is gray and in italics, the baseline file is still valid. The gray
and italics indicate that the Cary is idling outside the abscissa range of the
baseline file.

11 Start the run

Click the Start button or choose Start from the Commands menu to
start the Scan run.
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12 Name the data file and samples

a When you click Start, the ‘Save As’ dialog box will be
displayed. Enter the appropriate ‘File name’ for the data and
click Save.

b The ‘Sample Name’ dialog box will be displayed. Enter the
appropriate name for your sample and click OK. The Scan
run will commence and the corrected trace will be displayed
in the Graphics area. At the end of the run, the Cary will
create the report and also print it, if ‘AutoPrint’ has been
selected on the ‘Reports’ page of the ‘Setup’ dialog box.

Perform a scan in Signal-To-Noise mode (Cary 100-6000i)

This procedure describes how to perform a wavelength scan from
800 nm to 200 nm in signal-to-noise mode
(Cary 100/300/4000/5000/60001).

1 Setup data collection parameters
Setup dialog box

In Scan, click the Setup button or choose Setup from the Menu line
to display the ‘Setup’ dialog box and specify the method parameters
for a new method.

2 Set up instrument parameters

Setup dialog box | Cary page

a Set the appropriate abscissa mode for the scan in the ‘X
Mode’ field.

b  Set the wavelength range for the scan by entering the values
you require in the ‘Start’ and ‘Stop’ fields.

¢ Inthe ‘Y Mode’ field, select the ordinate mode.

Enter an upper and lower range in the ‘Y min.” and ‘Y max.’
fields to specify the displayed ordinate range. You can click
the ‘Autoscale’ button during the data collection to
automatically scale the display.

e Set the speed of the data collection by setting the ‘Ave. Time’
and ‘Data Interval’. The Data Interval is the wavelength
increment between data points. The ‘Scan Rate’ will
automatically update when selected.
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Make sure that ‘Cycle Mode’ is not selected.

3 Setup SBW, lamp and graphics options

Setup dialog box | Options page

a
b

Set the ‘SBW’ (spectral bandwidth).

If you are using a Cary 100/300/5000/6000i, set the ‘SBW’ for
the run. A good starting point is 2 nanometers if your method
does not specify a SBW.

Set the ‘Beam Mode’ for the run (usually ‘Double’).

For Cary 5000/6000i, the fixed SBW is used to automatically
alter the Energy level and maintain a constant signal level.

For Cary 4000/5000/6000i, set the ‘Slit Height’ to Full.

Click the UV/Vis button if you want both the lamps on during
the run.

Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This option is especially
useful when performing Scan runs overnight or unattended
for long periods of time.

Check Signal-to-Noise Mode, and set the required values for
the Acceptable S/N and the S/N Timeout.

Under ‘Display Options’, select ‘Individual Data’ to display
the collected data of each sample in individual graph boxes.
Choose the ‘Overlay Data’ to superimpose the collected data
of each sample in the Scan run in one graph box.

Setup dialog box | Independent page

On the ‘Independent’ page, make sure ‘Independent Control’ is not
selected.

4 Set up the baseline correction

Setup dialog box | Baseline page

Select ‘Baseline Correction’ to perform a baseline correction on each
sample data point.
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You can use a stored baseline by clicking ‘Baseline’ and opening the saved *.csw
baseline file.

5 Ensure no accessories are selected
Setup dialog box | Accessories 1 page

Make sure that no options are selected on this page and that no
accessories are installed.

Setup dialog box | Accessories 2 page

Make sure that no options are selected on this page and that no
accessories are installed.

Setup dialog box | Accessories 3 page
Make sure that no options are selected on this page and that no
accessories are installed.

6 Set up reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.
b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘AutoPrint’ to
automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the generated report.

If ‘AutoPrint’ is selected, the system will send the report information to the
specified printer as well as the Report area.

d Setup the ‘Peak Table’ reporting.
(1) Select Peak Labels.
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(ii) Click the Peak Information button and choose the ‘Peak
Type’, the ‘Labels Type’, the and set the ‘Peak Threshold’.
Click OK.

(iii) Select Maximum Peak to report the peak with the largest
peak threshold that exceeds the Peak Threshold value.

(iv) Select All Peaks to report all peaks meeting the Peak
Style criterion and exceeding the Threshold value.

e Setup ‘X-Y pairs’ reporting, if required. You can use the
actual Data Interval by which the data was collected or you
can make the Cary interpolate the points to a new Interval.

f  Select the ‘Autoconvert’ option you require. If you select
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at
the end of the data collection the system will automatically
generate a report and store the data in the Cary format as
well as ASCII XY pairs format in the current folder.

7 Set up storage of collected data
Setup dialog box | Auto Store page
Select Storage On (Prompt at End).

8 Set up visual system monitoring

Select Show Status Display on any Setup page, or from the View
menu, to display information about your current reaction.

9 Finish setup

Once you are satisfied with your method setup, click OK to confirm
any changes you have made and close the ‘Setup’ dialog box.

10 Zero the instrument

Click Zero, or choose Zero from the Commands menu to perform a
Zero.

11 Measure a baseline

a Click Baseline or choose Baseline from the Commands
menu.
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b  When prompted, insert the blank sample into the sample
compartment front beam and click OK. After the baseline is
collected, the word ‘baseline’ will be displayed in red in the
ordinate status box, indicating that you are in baseline
correction mode and have a valid baseline file for the
correction.

If the word ‘baseline’ is gray and in italics, the baseline file is still valid. The gray
and italics indicate that the Cary is idling outside the abscissa range of the
baseline file.
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12 Start the run

Click the Start button or choose Start from the Commands menu.

13 Name your samples

Once you click ‘Start’, the ‘Sample Name’ dialog box will be
displayed. Enter the appropriate name for you sample and click OK.
The Scan run will commence and the corrected trace will be
displayed in the Graphics area.

If for a particular point, the set Acceptable S/N cannot be met in the
set ‘S/N Timeout’ time, the Cary will collect the point as normal
(using the S/N Timeout as the Ave. Time) and display the message
SNR Timeout in the hardware status area.

14 Save your data

When the Cary has measured the sample, the ‘Save As’ dialog box
will be displayed. Enter the appropriate name for your sample and
click Save. The Cary will then create the report and print it, if
‘AutoPrint’ has been selected on the ‘Reports’ page of the ‘Setup’
dialog box.
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Perform a scan in Independent mode (Cary 5000)
This procedure describes how to perform a wavelength scan from
2200 nm to 400 nm in Independent mode (Cary 5000 only).

1 Set up data collection parameters
Setup dialog box

In Scan, click the Setup button or choose Setup from the Menu line
to display the ‘Setup’ dialog box and specify the method parameters
for a new method.

2 Set up instrument parameters

Setup dialog box | Cary page

a Set the appropriate abscissa mode for the scan in the ‘X
Mode’ field.

b Set the wavelength range for the scan by entering the values
you require in the ‘Start’ and ‘Stop’ fields.

In the ‘Y Mode’ field, select the ordinate mode.

d Enter an upper and lower range in the ‘Y min.” and ‘Y max.’
fields to specify the displayed ordinate range. You can use
the ‘Autoscale’ button during the data collection to
automatically scale the display.

e Do not set any Scan Controls, such as ‘Ave. Time’ or ‘Data
Interval’, as the settings in Independent mode will override
these.

f  Make sure that ‘Cycle Mode’ is not selected.
3 Setup SBW, lamp and graphics options
Setup dialog box | Options page

a Do not set the ‘SBW’ (spectral bandwidth) or Energy, as the
settings in Independent mode will override these.

b Setthe ‘Beam Mode’ for the run (usually ‘Double’).
¢ Set the ‘Slit Height’ to Full.

d Click the UV/Vis button if you want both lamps on during the
run.
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e Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This option is especially
useful when performing Scan runs overnight or unattended
for long periods of time.

f Under ‘Display Options’, select ‘Individual Data’ to display
the collected data of each sample in individual graph boxes.
Choose ‘Overlay Data’ to superimpose the collected data of
each sample in the Scan run in one graph box.

4 Set up the signal level controls (SBW/energy) for the scan

Setup dialog box | Independent page
a Select Independent Control.

b  Select the Auto ‘Measurement Mode’. This will mean that the
Cary will use a Fixed SBW (spectral bandwidth) in the UV-Vis
region and a fixed Energy level in the near infra-red region.

¢ Under ‘UV-Vis’, set the parameters you require in the UV-Vis
region. Good starting values are: Ave. Time = 0.1, Data
Interval = 1, Scan Rate = 600, SBW = 2.

d Under ‘NIR’, set the parameters you require in the near infra-
red region. Good starting values are: Ave. Time = 0.1, Data
Interval = 4, Scan Rate = 2400, Energy=1.

5 Set up baseline correction
Setup dialog box | Baseline page
Select Baseline Correction to perform a baseline correction on each

sample data point.

You can use a stored baseline by clicking ‘Baseline’ and opening the saved *.csw
baseline file.
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6 Ensure no accessories are selected
Setup dialog box | Accessories 1 page

Make sure that no options are selected on this page and that no
accessories are installed.

Cary WinUV Software Manual



How To...

Setup dialog box | Accessories 2 page

Make sure that no options are selected on this page and that no
accessories are installed.

Setup dialog box | Accessories 3 page

Make sure that no options are selected on this page and that no
accessories are installed.

7 Setup reporting and printing requirements
Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘AutoPrint’ to
automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the generated report.

If ‘AutoPrint’ is selected, the system will send the report information to the
specified printer as well as the Report area.

d Setup the ‘Peak Table’ reporting.
(i) Select Peak Labels.

(ii) Click the Peak Information button and choose the ‘Peak

Type’, the ‘Labels Type’, and set the ‘Peak Threshold’. Click
OK.

(iii) Select Maximum Peak to report the peak with the largest
peak threshold that exceeds the Peak Threshold value.

(iv) Select All Peaks to report all peaks meeting the Peak
Style criterion and exceeding the Threshold value.

e Setup X-Y pairs’ reporting, if required. You can use the
actual Data Interval by which the data was collected or you
can make the Cary interpolate the points to a new Interval.
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f  Select the ‘Autoconvert’ option you require. If you select
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at
the end of the data collection the system will automatically
generate a report and store the data in the Cary format as
well as ASCII XY pairs format in the current folder.

8 Set up storage of collected data
Setup dialog box | Auto Store page
Select Storage On (Prompt at End).

9 Set up visual system monitoring

Select Show Status Display on any Setup page, or from the View
menu, to display information about your current reaction.

10 Finish setup

Once you are satisfied with your method setup, click OK to confirm
any changes you have made and close the ‘Setup’ dialog box.

11 Zero the instrument

Click Zero to zero the system. Alternatively, choose Zero from the
Commands menu to perform a zero.

12 Measure a baseline

a Click Baseline or choose Baseline from the Commands
menu.

b When prompted, insert the blank sample into the sample
compartment front beam and click OK. After the baseline is
collected, the word ‘baseline’ will be displayed in red in the
ordinate status box, indicating that you are in baseline
correction mode and have a valid baseline file for the
correction.

If the word 'baseline’ is gray and in italics, the baseline file is still valid. The gray
and italics indicate that the Cary is idling outside the abscissa range of the
baseline file.

13 Start the run

Click the Start button or choose Start from the Commands menu.
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14 Set up sample names

When you click Start, the ‘Sample Name’ dialog box will be displayed.
Enter the appropriate name for you sample and click OK. The Scan
run will commence and the corrected trace will be displayed in the
Graphics area.

15 Save your data

When the Cary has measured the sample, the ‘Save As’ dialog box
will be displayed. Enter the appropriate name for your sample and
click Save. The Cary will then create the report and print it, if

‘AutoPrint’ was selected on the ‘Reports’ page of the ‘Setup’ dialog
box.

Scanning Kinetics
The following Scanning Kinetics procedures are described:
= Collecting data (Cary 50)

= Collecting data using the Multicell Holder with temperature
control (Cary 100-6000i)

Collect data (Cary 50)

This procedure describes how to perform a multicell, multi-stage
wavelength scan with baseline correction from 600 to 500 nm at
ambient temperature (Cary 50). You can then use the data to create
kinetics continuums in order to calculate reaction rates.

1 Setup data collection parameters
Setup dialog box

In Scanning Kinetics, click Setup or choose Setup from the Menu line
to display the ‘Setup’ dialog box and specify the method parameters
for a new method.

2 Set up instrument parameters
Setup dialog box | Cary page

a Set the wavelength range for the scan by entering the values
you require in the ‘Start’ and ‘Stop’ fields.
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Enter an upper and lower range value in the ‘'Y min.” and ‘Y
max.’ fields to specify the displayed ordinate range.

You now need to set the speed of the data collection by
setting the ‘Ave. Time’ and ‘Data Interval’. In the ‘Ave.
(averaging) Time’ field, enter the required value. 0.1 seconds
is a good starting value.

In the ‘Data Interval’ field, enter the wavelength increment
you require between data points. 0.5 nanometers is a good
starting point. The Cary will automatically update the ‘Scan
Rate’ field when you select it.

Set up rate parameters

Under ‘Collect Timing’, select Advanced Collect. This enables
you to set up different data collection procedures for the
multiple rates in your reaction.

The ‘Advanced Collect’ facility enables you to collect data more frequently during
the crucial stages of your reaction, and less frequently where you know there will
not be much activity.
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Enter the number of different reaction rates that you require
in the ‘Number of Stages’ field. The number you set here will
be reflected in the table below.

Specify how long the Cary will wait after reading each cell
before it starts another reading cycle by setting the ‘Cycle
time’ for each rate stage.

Specify the duration of the Scanning Kinetics run by setting
the ‘Stop time’ for each rate stage.

Select the baseline correction type
Setup dialog box | Baseline page

Select Baseline correction. This will force the Cary to use a baseline
scan to perform a baseline correction on the sample data. The
correction will be performed on each point before it is displayed.
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You can use a stored baseline. To do this, click the ‘Retrieve Baseline file" button
and open the saved *.csk baseline file.

5 Set up the Multicell Holder accessory

Setup dialog box | Accessories page

a Ensure that you have the appropriate accessories installed
before starting the run.

b Select Use Cell Changer to enable the Multicell Holder
accessory.

¢ Click Select Cells and select the cells you require from the
available cells under ‘Use Cells’.

d Select Multi Zero to turn on the ‘Multi Zero’ facility.

6 Setup analysis parameters
Setup dialog box | Analyze page

This page is used for post-run analysis.

7 Setup reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. Select
‘Parameters’ to include your experimental parameters in the
report. Select ‘Graph’ to include a graph in the generated
report.
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If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as to the Report area. However, if ‘Auto Print’ is not
selected, the report will only be sent to the Report area and can be viewed by
choosing ‘Report” from the ‘View" menu.
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d Select Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

e Select the ‘Autoconvert’ option you require. If you select
‘ASCII’ or ‘ASCII with Log’, at the end of the data collection
the system will automatically generate a report and store the
data in the Cary format as well as ASCII XY pairs format in
the current folder.

8 Set up storage of collected data
Setup dialog box | Auto Store page

Select Storage On (Prompt at Start), to set the Cary to prompt you
for a file name before the start of the Scanning Kinetics run.
9 Set up visual system monitoring
Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.
10 Finish setup
Click OK to save any changes you have made and close the ‘Setup’
dialog box.
11 Measure a baseline
If you do not have a valid baseline file, the Cary will prompt you to
click Baseline.
Click Baseline to set up the baseline collection.
b If you like, change the name of the blank.

¢ Insert blank samples into the cell changer to collect the
0ADbs/100%T baseline scans, and click OK.
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The system will set up the Graphics area and the Cary will collect the
baseline scan. After the collection, the word ‘baseline’ will be
displayed in red in the ordinate status box, indicating that you are in
baseline correction mode and you have a valid baseline file for the
correction.

12 Zero the instrument

a Click Zero or choose Zero from the Commands menu to
perform a zero.

b If you like, change the name of the blank/s.
¢ Insert blank samples into the appropriate positions of the
Multicell Holder and click OK.
13 Start the run
a Click Start or choose Start from the Commands menu to

start a data collection. Do not add your active reagent at
this time.

At this point, the system will display the ‘Save File’ dialog box if you have
selected ‘Storage On (Prompt at Start)’ on the ‘Auto Store’ page of the 'Setup’
dialog box. If so, enter the file name for this Scanning Kinetics run in the ‘File
name’ field and click Save.

b The system will display a ‘Cell Loading Guide’. If you like,
change the names of the samples.

¢ Place the sample solution(s) in the correct cell positions and
click OK. The ‘Sync Start’ dialog box will be displayed.

d Add your active reagent just before the countdown reaches
0:00, or commence the data collection by clicking OK.

At the end of the run, you can determine the actual Stop Time by
observing the last value in the ‘Time’ column of the ‘User Data Form.’
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Collect data using the Multicell Holder with temperature control
(Cary 100-6000i)

This procedure demonstrates how to perform a multicell, multi-stage
wavelength scan with baseline correction from 600 to 500 nm at

37 °C using the Temperature Controller accessory with the Multicell

Holder accessory (Cary 100/300/4000/5000/6000i). You can then use
the data to create kinetics continuums in order to calculate reaction

rates.

1 Set up data collection parameters
Setup dialog box

In Scanning Kinetics, click the Setup button or choose Setup from
the Menu line to display the ‘Setup’ dialog box and specify the
method parameters for a new method.

2 Select the baseline correction type
Setup dialog box | Baseline page

Select Baseline Correction. This will force the Cary to use a baseline
scan to perform a baseline correction on the sample data. The
correction will be performed on each point before it is displayed.

You can use a stored baseline. To do this, click the ‘Retrieve Baseline File’ button
and open the saved *.csk baseline file.

3 Set up the Multicell Holder accessory

Setup dialog box | Accessories page

a Ensure that you have the appropriate accessories installed
before starting the run.

b Select Use Cell Changer to enable the Multicell Holder
accessory.

¢ Choose the type of Multicell Holder you are using (6 x 6 or
8 x 6).
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If you are using a Series | 6 x 6x (Cary 100/300), you must calibrate the cell
changer using the Align application before starting experiments.

d Click Select Cells and select the cells you require under ‘Use
Cells’.

For Front Beam analysis, select ‘Cell 1-Cell 6’ (6 x 6) or
‘Cell 1-Cell 8’ (8 x 6). This will ensure that all front cell
positions in the Multicell Holder will be measured during
your Scanning Kinetics analysis.

e Select Multi Zero.

4 Set up accessories for reaction temperature control and
temperature display

a Ifyou are not using a Peltier-controlled accessory (for
example, the water-thermostatted 8 x 6), ensure that you
have the Temperature Controller accessory installed before
starting the run.

b Select Automatic Temperature Setting and click
Temperature Controller to enable the accessory.

¢ Set the monitoring temperature by entering the block
temperature as 37 °C. (The monitoring device is selected in
Step 6d.)

d Under ‘Temperature Display’, select Block and Probe 1 to
view the temperature of the Multicell Holder block and one
temperature probe in the ‘Status Display’ window.

5 Set up instrument parameters

Setup dialog box | Cary page

a Set the appropriate abscissa mode for the scan in the
‘X Mode’ field.

b Set the wavelength range for the scan by entering the values
you require in the ‘Start’ and ‘Stop’ fields.

¢ In the ‘Y Mode’ field, select the ordinate mode you require.

Enter an upper and lower range value for ‘Y min.” and
‘Y max.’ to specify the displayed ordinate range.
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e Set the speed of the data collection by setting the ‘Ave. Time’
and ‘Data Interval’. The Data Interval is the wavelength
increment between data points. The ‘Scan Rate’ will
automatically update when selected.

6 Set up rate parameters

Under ‘Collect Timing’, select Advanced Collect to set up different
data collection procedures for the multiple rates in your reaction.

The ‘Advanced Collect’ facility enables you to collect data more frequently during
the crucial stages of your reaction, and to collect data less frequently where you
know there will not be much activity.
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a Enter the number of different reaction rates that you require
in the ‘Number of Stages’ field. The number you set here will
be reflected in the table below.

b  Specify how long the Cary will wait after reading each cell
before it starts another reading cycle by setting the ‘Cycle
time’ for each rate stage.

¢ Specify the duration of the Scanning Kinetics run by setting
the ‘Stop time’ for each rate stage.

d Choose the desired temperature monitoring device in the
‘Monitor’ field. The ‘Start’ button will not be enabled until the
temperature of the selected monitor is within 0.5 °C of the
block temperature set on the ‘Accessories’ page (Step 4c¢).

7 Set up spectral bandwidth or energy and lamp options

Setup dialog box | Options page
Set the ‘SBW’ (spectral bandwidth) for the run.
Set the ‘Slit Height’ to Full.

¢ Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This is especially useful
when performing data collections overnight or unattended
for long periods of time.

d Click the UV/Vis button if you want both lamps on during the
run.

Cary WinUV Software Manual



How To...

e Enter your required ‘Source Changeover’ wavelength in the
corresponding field. If you are using a Cary 56000/6000i, also
enter the detector and grating changeover wavelengths (800
nanometers is recommended for both).

8 Set up analysis parameters
Setup dialog box | Analyze page

This page is used for post-run calculations.

9 Set up reporting and printing requirements

Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.
b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate check
boxes under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. Select ‘Graph’
to include a graph in the generated report.

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as to the Report area.

d Select Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

e Select the ‘Autoconvert’ option you require.

f Ifyou choose ‘Select for ASCII (csv)’ or ‘Select for ASCII
(csv) with Log’, at the end of the data collection the system
will automatically generate a report and store the data in the
Cary format as well as ASCII XY pairs format in the current
folder.

10 Set up storage of collected data
Setup dialog box | Auto Store page

Select Storage On (Prompt at Start), to set the Cary to prompt you
for a file name before the start of the Scanning Kinetics run.
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11 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.

12 Finish setup

Click OK to save any changes you have made and close the ‘Setup’
dialog box. Depending on the cells selected in the Multicell Holder,
the Cary may then inform you that it will perform a dual single beam
calibration. Click OK.

13 Measure a baseline

a Ifyou do not have a valid baseline file, the Cary will prompt
you to click Baseline to set up the baseline collection.

b  The system will display a ‘Cell Loading Guide’. If you like,
change the name of the blank.

¢ Insert blank samples into the cell changer to collect the
0Abs/100%T baseline scans and click OK.

The system will set up the Graphics area and the Cary will collect the
baseline scan. After the collection, the word ‘baseline’ will be
displayed in red in the ordinate status box, indicating that you are in
baseline correction mode and you have a valid baseline file for the
correction.

If you want to use the baseline again with other samples, save the
method using ‘Save Method As’ on the ‘File’ menu. Then, when you
re-open the method, the baseline will also open and be ready to use.
It is preferable to save the baseline with the method, rather than a
baseline file, as that way you can be sure that all your collection
parameters are exactly the same for the new Scanning Kinetics runs.
However, Good Laboratory Practice recommends that you collect a
new baseline for each laboratory session.

14 Zero the instrument
Click Zero or choose Zero from the Commands menu.
b If you like, change the name of the blank/s.

¢ Insert blank samples into the appropriate positions of the
Multicell Holder and click OK.
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15 Start the run

a Click the Start button to start a data collection. Alternatively
you can choose Start from the Commands menu. Do not add
your active reagent at this time.

At this point, the system will display the ‘Save File" dialog box if you have
selected ‘Storage On (Prompt at Start)’ on the ‘Auto Store’ page of the 'Setup’
dialog box. If so, enter the file name for this Scanning Kinetics run in the ‘File
name’ field and click ‘Save’.

b The system will display a ‘Cell Loading Guide’. If you like,
change the names of the samples.

¢ Place the sample solution(s) in the correct cell positions and
click OK. The ‘Sync Start’ dialog box will be displayed.

d Add your active reagent just before the countdown reaches
0:00, or commence the data collection by clicking OK.

e At the end of the run, determine the actual Stop Time by
observing the last value in the ‘Time’ column of the ‘User
Data Form’.
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Perform a Simple Reads measurement at a single wavelength

This procedure describes how to perform a Simple Reads
measurement at a single wavelength.

1 Set up instrument parameters (wavelength, Y mode)

d

In Simple Reads, click the Setup button or choose Setup
from the Menu line to display the ‘Setup’ dialog box.

Select Read at Wavelength and enter the required
wavelength.

Under ‘Y Mode’, select the ordinate mode you require. The
ordinate mode determines the way in which the photometric
value is measured and displayed in your report.

Click OK. The instrument will change to the new wavelength.

2 Zero the instrument

Make sure that the sample compartment is clear (or you have a blank
in position) and click Zero. (Wait for the ordinate reading to reach

‘0)

3 Read the sample

Insert the sample into the sample compartment. Wait while
the instrument changes to the specified wavelength. The
current wavelength is displayed in the Abscissa status
display at the top right of the application window.

Click the Read button to perform photometric measurements
on the sample at the specified wavelength. The result appears
in the Report area and includes the ordinate reading
obtained and the wavelength at which the reading was
measured.

4 Print the results

You can print the contents of the Report area by clicking the Print

button.
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Thermal
The following Thermal procedures are described:
= Performing a run and determine T,, using Derivative calculations

= Performing a run and determine 7, using Hyperchromicity
calculations

Perform a run and determine T using derivative calculations

This procedure describes how to perform a Thermal run using a
single temperature rate and automatically calculate T,, from the first
derivative.

1 Setup data collection parameters
Setup dialog box

In Thermal, click the Setup button, or choose Setup from the Menu
line to display the ‘Setup’ dialog box and specify the method
parameters for a new method.

2 Set up instrument parameters

Setup dialog box | Cary page

a In the ‘Wavelength’ field, enter the wavelength that you
would like to monitor.

b In the ‘SBW’ field, enter the required spectral bandwidth.

¢ In the ‘Ave. (averaging) Time’ field enter the required value.

For slow changes in temperature (that is, slow ramp rates), it is recommended
that a long Ave. Time (for example, 2 to 3 seconds) be set.

d Enter the ordinate values in the ‘Y min.” and ‘Y max.’ fields.
3 Setup rate parameters
a Specify the ‘Collect Temperatures’ parameters:

b In the ‘Start °C’ field, enter the temperature at which you
want to start the data collection.
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Once you click ‘0K’ to close the ‘Setup” dialog box, the Cary will drive the
temperature to the specified Start Temperature.

¢ In the ‘Return °C’ field, enter the temperature to which you
want the Temperature Controller to drive at the end of the
data collection.

d Use ‘Monitor’ to specify whether the temperature will be
measured at the block or the probe.

e Select Simple Collect to set a single rate of temperature
change for the entire Thermal run.

f Enter the ‘Data Interval’, ‘Ramp Rate’, ‘End Temperature’
and ‘Hold time’. Select the stages where you want to collect
data in the ‘Collect Data’ column.

4 Setup the lamp source operation and data display options

Setup dialog box | Options page

a Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This is especially useful
when performing collections overnight or unattended for
long periods of time.

b Click UV/Vis if you want both lamps on during the run.

¢ Under ‘Display Options’, select ‘Individual Data’ to display
the collected data of each sample in individual graph boxes.
Select ‘Overlay Data’ to superimpose the collected data of
each sample in the run in one graph box.

5 Ensure no accessories are selected
Setup dialog box | Accessories page

Click the Accessories tab and make sure that no accessories are
selected.

6 Set up the analysis to reduce measurement interference
Setup dialog box | Analyze page

Select Smoothing and nominate the smoothing ‘Interval’ and ‘Filter
Size’ to control the number of measurement points to be averaged.
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7 Setup a derivative method of analysis

a Select Derivative to calculate the temperature at which 50%
of the DNA strands have separated (T,,).

b Select Autocalculate to automatically perform a derivative
calculation at the end of each run.

You can manually perform the derivative calculation, once the run is complete.

¢ Define the range over which to calculate and plot the first
derivative of the selected scan.

d Enter the Interval at which data is sampled in order to
perform a derivative calculation. A derivative calculation
involves the collection of points from a plot. Selection of
these points is dependent upon the data interval chosen. The
data points are then used to generate a separate trace from
which a derivative calculation is performed. The selection of
the Derivative Interval is dependent on the rate of data
collection. If data is collected every 0.1 °C then a derivative
interval of 0.1 °C will give the most accurate result.

e Enter the Filter Size you require for the derivative
calculation. The derivative uses a Savitzky Golay technique
where a number of points surrounding an individual point
are averaged to produce a new, smoothed point. For example,
a five point derivation uses the two data points before and
after each data point.

The larger the filter size, the more data points that are included in the filter for
smoothing.

f Enter the temperature that you want to start the calculation
in the ‘Low Calculation Limit’ field.

g Enter the temperature where you want to end the calculation
in the ‘High Calculation Limit’ field.
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8 Set up other recalculations and normalization

Setup dialog box | Reports page
a Select Calculation and enter or select an equation in the field
to perform a calculation.
b Select Correction and enter the ‘Correction Temperature’ to
perform a Thermal Expansion Correction.

¢ Select Normalize and enter the temperature at which you
would like the data to be normalized.
9 Set up reporting and printing requirements
Enter your name in the ‘Name’ field.
b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate items
under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. Select ‘Graph’
to include graphics in the generated report.

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as the Report area.

d Select the ‘Autoconvert’ option you require. If you select
‘ASCII’ or ‘ASCII with Log’, at the end of the data collection
the system will automatically generate a report and store the
data in the Cary format as well as ASCII XY pairs format in
the current folder.

10 Set up storage of collected data
Setup dialog box | Auto Store page
Select Storage Off.

11 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu to display information about your current reaction.
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12 Finish setup

Once you are satisfied with your method setup, click OK to save any
changes made and close the ‘Setup’ dialog box. The Cary will start to
drive the temperature to the start temperature.

13 Zero the instrument

a Click Zero or choose Zero from the Commands menu. A
‘Loading Guide’ will be displayed.

b Place a blank solution in the cell that is in the light beam in
sample compartment and click OK. The system will perform
an instrument zero on the blank solution.

14 Equilibrate the sample

Make sure that the Cary has reached the start temperature and has
been at this temperature for 2 to 3 minutes. If you entered a hold
time in the ‘Stage 1 Hold’ field (Cary page), the system will wait and
equilibrate at this temperature for the hold time before proceeding
with the ramp. It is not necessary to wait to click the ‘Start’ button.

15 Start the run

a Click the Start button or choose Start from the Commands
menu. The system will display a ‘Loading Guide’.

b Load your sample into the front cell holder.

¢ Enter the name of your sample then click OK. The Cary will
wait for the specified hold time and then perform the run.

16 After the run

At the end of the run, depending on what you have set in previous
steps, the ‘User Data Form’ may appear. If it does, fill in the
appropriate entries in the columns provided for the sample and click
OK. The calculation equation will be displayed in the report.

Also, since ‘Autocalculate’ (under ‘Derivative’) was selected on the
‘Analyze’ page of the ‘Setup’ dialog box, a derivative calculation will
be performed at the end of the data collection.

The sample under investigation, with corresponding 7, values, will
be displayed in the Report area as well as parameters used to
generate the selected data file, temperature profile, and the method
used to contain the T, value.
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A plot will be displayed in the Graphics area indicating the original
temperature data and a plot of the first derivative of the selected
scan. The point at which the derivative plot peaks (that is, maximum
or minimum gradient on the original plot) is reported as the T, value
and the original plot is marked with an arrow to indicate this point.

To view a plot of the collected data, choose Graph from the View
menu.
17 Save your data

a From the File menu choose Save Data As.

b In the ‘Files of Type’ field, click Batch.

¢ Enter the file name for this run in the ‘File name’ field.

d Click Save.

Perform a run and determine T using hyperchromicity calculations

This procedure describes how to perform a Thermal run with
multiple temperature ramps and determine 7, using a
hyperchromicity calculation.

1 Setup data collection parameters
Setup dialog box

In Thermal, click the Setup button or choose Setup from the Menu
line to display the ‘Setup’ dialog box and specify the method
parameters for a new method.

2 Set up instrument parameters
Setup dialog box | Cary page

a In the ‘Wavelength’ field, enter the wavelength that you
would like to monitor.

b Inthe ‘SBW’ field, enter the required spectral bandwidth.

¢ In the ‘Ave. (averaging) Time’ field, enter the required value.

For slow changes in temperature (that is, slow ramp rates), it is recommended
that a long Ave. Time (for example, 2 to 3 seconds) be set.
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d Enter the ordinate values in the ‘Y min.’ and ‘Y max.’ fields.
3 Setup the collect temperature parameters

a In the ‘Start °C’ field, enter the temperature at which you
want to start the data collection.

Once you click ‘OK’ to close the ‘Setup’ dialog box, the Cary will drive the
temperature to the specified Start Temperature.

b In the ‘Return °C’ field, enter the temperature to which you
want the Temperature Controller to drive at the end of the
data collection.

¢ Use ‘Monitor’ to specify whether the temperature will be
measured at the block or at the probe.

d Select Advanced Collect.

e Enter the number of changes in temperature rate that you
require in the ‘Number of Stages’ field.

An increase or decrease in the temperature must be a separate stage.

f  Enter the ‘Data Interval’, ‘Ramp Rate’, ‘End Temperature’
and ‘Hold time’. Select the stages where you want to collect
data in the ‘Collect Data’ column.

4 Setup the lamp source operation and the data display options

Setup dialog box | Options page

a Select Auto Lamps Off if you want to automatically turn off
the lamps at the end of a collect. This is especially useful
when performing Thermal data collections overnight or
unattended for long periods of time.

b Click UV/Vis if you want both lamps on during the run.

¢ Under ‘Display Options’, select ‘Individual Data’ to display
the collected data of each sample in individual graph boxes.
Or select ‘Overlay Data’ to superimpose the collected data of
each sample in the run in one graph box.
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5 Set up the Multicell Holder accessory

Setup dialog box | Accessories page

a Ensure that you have the Thermostattable 6 x 6 Multicell
Holder accessory installed before starting the run.

b Select Use Cell Changer to enable the accessory.

¢ Click Select Cells, and select the cells you require from the
available cells under ‘Use Cells’.

d Select Multi Zero to turn on the ‘Multi Zero’ facility.

e Clear Blank Correction.
6 Setup temperature display
Under ‘Temperature Display’, select Block and Probe 1 to turn on
monitoring of the Multicell Holder block and one temperature probe.
7 Setup the RBA accessory

a Under ‘RBA’, select Use RBA.

If you are using a Series | RBA, you must configure it using the Align application
before starting any experiments.

b Select either ‘Attenuation’ and enter the Abs value or select
‘Position’ and enter the angle position.

8 Set up the analysis to reduce measurement interference
Setup dialog box | Analyze page

Select Smoothing and nominate the smoothing ‘Interval’ and ‘Filter
Size’ to control the number of measurement points to be averaged.
9 Set up your method of analysis

a Select Hyperchromicity to calculate the temperature at
which 50% of the DNA strands have separated (T,,).

The hyperchromicity calculation is performed once the run is completed.
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b Select Van't Hoff Calculation to calculate a Van't Hoff plot
(Lm(K(T)) vs 1000/T(deg K)) and activate the
‘Hyperchromicity’ items.

¢ Select ‘Self Complementary’ if the DNA molecule being
analyzed consists of identical strands. Otherwise, select ‘Non
Self Complementary’.

d Enter the concentration in the ‘Total Conc of Strands’ field.

e Enter the ‘Molecularity’ (that is, the number of strands) of
the hybrid. For example, enter ‘2' if the DNA molecule being
analyzed consists of two strands.

f Select A G to perform A G (free energy) and K (equilibrium
constant) calculations.

g In the ‘Number of Temperatures’ field, specify the number of
temperatures at which you would like to perform the A G and
K calculations. The number set here is reflected in the
‘Temperature’ table below this field.

h Enter the required temperature in each cell of the
‘Temperature’ table.

10 Set up other recalculations and normalizations

Setup dialog box | Calculations page

a Select Calculation and enter or select an equation to perform
a calculation.

b Select Correction and enter the ‘Correction Temperature’ to
perform a Thermal Expansion Correction.

¢ Select Normalize and enter the temperature at which you
would like the data to be normalized.

11 Set up your reporting and printing requirements
Setup dialog box | Reports page
a Enter your name in the ‘Name’ field.

b Enter a comment relating to your experiment in the
‘Comment’ field.

¢ Set up your report style by selecting the appropriate items
under ‘Options’. For example, select ‘Auto Print’ to
automatically obtain a printout of your report. Select ‘Graph’
to include graphics in the generated report.

Cary WinUV Software Manual 119



How To...

If ‘Auto Print’ is selected, the system will send the report information to the
specified printer as well as the Report area..
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d Select the ‘Autoconvert’ option you require. If you select
‘ASCII’ or ‘ASCII with Log’, at the end of the data collection
the system will automatically generate a report and store the
data in the Cary format as well as ASCII XY pairs format in
the current folder.

12 Set up storage of collected data
Setup dialog box | Auto Store page
Select Storage On (Prompt at End).

13 Set up visual system monitoring

Select Show Status Display on any of the Setup pages, or from the
View menu, to display information about your current reaction.

14 Finish setup

Once you are satisfied with your method setup, click OK to save any
changes made and close the ‘Setup’ dialog box.

15 Zero the instrument

a Click Zero or choose Zero from the Commands menu. The
system will display a ‘Cell Loading Guide’.

b  Place the blank solutions in the correct positions in the
holder then click OK to zero the specified cells.

16 Equilibrate the samples

Ensure that the start temperature has been reached and held at this
temperature for 2 to 3 minutes. If you entered a hold time in the
‘Stage 1 Hold’ field (on the ‘Cary’ page), the system will wait and
equilibrate at this temperature for the hold time before proceeding
with the ramp, and it is not necessary to wait to click the ‘Start’
button.
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17 Start the run

Click the Start button or choose Start from the Commands menu to
start the Thermal run. The ‘Save As’ dialog box will be displayed.

18 Set up file name and trace names for the data

a Enter the appropriate name for your run and click Save. The
system will display a ‘Cell Loading Guide’.

b Place the solutions in the correct cell positions in the holder.

¢ Enter the name of each sample in the corresponding field
then click OK.

The Cary will wait for the specified hold time and then perform the
Thermal run.

19 After the run

At the end of the run, depending on what you have set in previous
steps, the ‘User Data Form’ may appear. If it does, fill in the columns
for each sample trace and click OK. The calculation equation will be
displayed in the report.

20 Hyperchromicity calculations

The Cary WinUV software will now prompt you to use the Thermal
ruler to define various limits for the hyperchromicity calculations.

a A prompt will be displayed asking you to select the
Associated DNA limits using the Ruler. Click OK. The cursor
changes to ruler mode.

b Position the mouse pointer on the Thermal curve at one end
of the linear region of the Associated DNA part of the curve
(before transition). Click and drag along the curve and
release at the other end of the linear region.

The software will automatically calculate a linear least
squares line between the selected points and extrapolate to
both ends of the melting curve.

¢ An ‘Associated DNA Limits’ dialog box will be displayed,
displaying the upper and lower limits that you selected with
the Thermal Ruler. Click OK to accept the calculated line.
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d A prompt will then appear asking you to select the
‘Deassociated DNA limits’ using the Ruler. Click OK on this
prompt. The cursor changes to ruler mode.

e Position the mouse pointer on the Thermal curve at one end
of the linear region of the Deassociated DNA part of the
curve (after the transition). Click and drag along the curve
and release at the other end of the linear region.

The software will automatically calculate a linear least
squares line between the selected points and extrapolate to
both ends of the melting curve.

f A ‘Deassociated DNA Limits’ dialog box will be displayed

displaying the upper and lower limits that you selected with
the ruler. Click OK to accept the calculated line.

The Associated and Deassociated DNA Limits dialog boxes allow you to re-select
your limits if you are not satisfied with the linear least squares lines drawn in the
graph box. To do this, click ‘Retry” and select another region. If you wish to exit
from the calculation mode, click ‘Cancel’. The ruler trace is removed from the
graph.

The Linear Region Associated and Deassociated correction points are displayed
in the Report area.

If the two extrapolated lines cross at any point, a warning will be displayed. Click
‘Cancel” and repeat steps (a) to (f) above and re-select the linear regions. Click
‘Ignore’ to proceed with the calculation using the regions you have selected.
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Using the lines calculated in the previous steps, the software will
automatically create a second graph box and display the calculated
Alpha curve.

g A prompt will be displayed asking you to select the range on
the Alpha curve that will be used for the T, calculation. Click
OK to make your selection.
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h Position the mouse pointer on the alpha curve at one end of
the linear region. Click and drag along the curve and release
at the other end of the linear region.

i An ‘Alpha T,, Limits’ dialog box will be displayed displaying
the selected limits. Click ‘Retry’ to reselect the limits, if
required. Click OK to accept the selected ranges. A linear
least squares line is drawn between the selected points and
the value of temperature where 25 = 0.5 is calculated to give
the T,, value. (The T,, value is automatically reported in °C
and K.)

If you have chosen the Van't Hoff Calculation method to calculate
A G and K:

j  Using the data calculated in Step (i) above, the system
automatically creates a third graph box displaying a Van't
Hoff plot. A prompt will be displayed asking you to select the
required range on the Van't Hoff plot to calculate A G and K.
Click OK.

k Position the mouse pointer on the Van't Hoff curve at one end
of the linear region. Click and drag along the curve and
release at the other end of the linear region.

I A ‘Van't Hoff Limits’ dialog box will also appear, displaying
the upper and lower limits that you selected with the ruler.

Click OK to accept the calculated line. Alternatively, click
‘Retry’ to reselect the limits using the ruler.

If there is an error in the Van't Hoff calculation, you will be prompted to reselect
the linear region.

A linear least squares line is calculated between these points and is
extrapolated to both ends of the Van't Hoff plot. The slope and
intercept of the calculated line gives the enthalpy and entropy of the
hybrid formation (A H° and A S° respectively).

The software will automatically send the results, using the calculated
alpha curve, to the Report area including;:

=  K(T,)experimental
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=  K(T,)from first principles

=  K(TT,)experimental/K(T, )from first principles

21 Step 20 will be repeated for each sample trace measured.

Perform a UV Dissolution run (Cary 50)

This procedure describes how to perform a UV Dissolution run using
a Cary 50.

1 Configure the instrument

a
b

In UV Dissolution, click the Configure button.

Double-click Instruments Configuration to expand the
‘Instrument Configuration’ group. Enter the details for the
instrument and any accessories to be used in your
experiment.

If you have already performed a UV Dissolution run, the settings for these fields
are stored in the pre-saved method or data file.

c

Click OK.

2 Set up method parameters

Click ‘Connect’ if the system is not online.
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Click Setup to display the ‘Method Setup’ window and create
a new method.

Expand the ‘Method’ group on the left by double-clicking
Method.

Click Method Setup.
Enter a method name in the ‘Method Name’ field.
Choose ‘Single Tester’ or ‘Dual Tester’.

Select Allow Media Change if a media change is required.
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g Select Use Fraction Collector if a fraction collector is
connected to the system.

h Select Dual Sample if multiple volumes are to be pulled using
the fraction collector.

i  Enter the name of the analyst in the ‘Setup By’ field. Verify
the time and date provided.

j  Enter the name of the reviewer in the ‘Approved By’ field.
Verify the time and date provided.
3 Setup sampling points
a On the left of the window, click Sampling Points.
b Under ‘Time’, enter the desired time point.
¢ Under ‘Increment time’, enter the desired increment time.
d Using the up/down arrows, set the number of desired time
points.

e Click Add Time Point to display the configured point details.

To delete a row, highlight the un-needed time point and click ‘Delete Row’.
To clear all sampling points and start over, click ‘Clear Table’.

By using ‘Increment time’ (the time between the time points) and ‘Time Points’
(the number of points that you wish to add), the number of time points entered
will be added and the time between each of the points will be the time entered in
the ‘Increment time’ field. By clicking ‘Add cycles’, the number of time points
will be displayed.

4 Setup product information
a On the left of the window, double-click Product.
b Click Product Information.
¢ Enter a product name in the ‘Product Name’ field.

d Describe the product being tested in the ‘Notes’ field.
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e If necessary, under ‘Sample Label 1’, ‘Sample Label 2’ and
‘Sample Label 3’, enter lot number, batch ID, company
information, department, and so on. These headings are
displayed in the report.

5 Setup media
a On the left of the window, click Media.

b In the ‘Media’ field, enter the type of media being used for the
UV Dissolution test. To use previously entered media, click
the down arrow and select the medium.

¢ In the ‘Media Information’ field, enter any applicable
information regarding the dissolution media.

d Enter appropriate information in the ‘Description’ field. To
use previously entered descriptions, click the down arrow
and select the description.

e In the ‘Media Volume’ field, enter the appropriate volume of
media (in milliliters). To use previously entered volumes,
click the down arrow and select the volume.

6 Setup media change

The ‘Media Change Parameters’ page is present when ‘Allow Media Change’ is
selected on the ‘Method Setup’ page.
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On the left of the window, click Media Change.

In the ‘Media Two’ field, enter the second type of media being
used for the UV Dissolution test.

¢ Enter appropriate information in the ‘Media Information’
and ‘Description’ fields.

d In the ‘Volume Removed’ field, enter the volume removed (in
milliliters).

e In the ‘Volume Replaced’ field, enter the volume to be added
(in milliliters).

f Click the Media Change Time point down arrow to select the
time point for the media change.
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g Select Automated Media Change if an automated system is
in place to change to the second medium.

7 Set up the dissolution tester spindle
a On the left of the window, double-click Tester.
b Click Spindle.

¢ Click the Apparatus Type down arrow to select an apparatus
type.

d In the ‘Initial Spin’ field, enter the initial spin rate (in
revolutions per minute).

e In the ‘Initial Spin Duration field’, enter the initial spin
duration (in seconds).

f In the ‘Spindle’ field, enter the spindle speed (in revolutions
per minute).

g In the ‘Spin Tolerance’ field, enter the speed tolerance (in
percent).

h In the ‘Infinity Spin’ field, enter the speed of the infinity spin
(in revolutions per minute).

i In the ‘Spin Duration’ field, enter the spin duration (in
minutes).

‘Infinity spin” and ‘Spin duration’ are unavailable for Media 1 if ‘Allow Media
Change’ has been selected on the ‘Method Setup’ page.

Configure ‘Spindle Media 2’ if a media change is required.

8 Setup temperature
a On the left of the window, click Temperature.
b If AutoTemp is installed, select AutoTemp.

¢ In the ‘Probes’ field, enter the number of temperature probes
installed.

d In the ‘Bath Temperature’ field, enter the desired bath
temperature (in degrees Celsius)
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e In the ‘Vessel Temperature’ field, enter the desired vessel
temperature (in degrees Celsius).

f Inthe ‘Temperature Tolerance’ field, enter the temperature
tolerance (+ °C).

g In the ‘Stabilization Delay’ field, enter a time (in seconds).

This time allows the media to equilibrate before sending temperatures to the
computer.
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h In the ‘Log Intervals’ field, enter the intervals (in minutes) to
report the bath temperature.

i  For an extended test, in the ‘Evaporation Rate’ field, enter
the evaporation rate (in milliliters per minute).

9 Set up sampling parameters
On the left of the window, click Sampling Parameters.

b In the 'Prime Volume’ field, enter the prime volume (in
milliliters). The prime volume should exceed the amount of
drawn media necessary to fill the whole system.

¢ In the ‘Pause Time’ field, enter the pause time (in seconds).
The pause time is the delay time between the end of the
prime cycle and the beginning of ultraviolet analysis.

d In the ‘Purge Volume’ field, enter the purge volume (in
milliliters). Enter a value that is at least twice the amount
necessary to fill the whole system with air. This ensures that
all stranded media is properly expelled.

e Ifa fraction collector is installed, configure it with the
‘Fraction Collector’ options.

f In the ‘Waste Drop Volume’ field, enter the waste drop
volume (in milliliters). The waste drop volume is the amount
of volume expelled before the sample is collected.

g In the ‘Active Channels’ field, enter the number of active
channels.

h In the ‘Sample Volume field’, enter the sample volume.
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i Ifreplacement media is installed, in the ‘Replacement
Volume’ field, enter the replacement volume (in milliliters).

j If a syringe pump is installed, configure it with the ‘Syringe
Pump’ options.

k In the ‘Plunger Speed’ field, enter the plunger speed (in steps
per second). Samples with a high viscosity may require a
slower plunger speed.

I In the ‘Aspiration Dwell’ field, enter the aspiration dwell
time (in seconds). The aspiration dwell time is how long the
plunger stops after pulling a sample. Samples with a high
viscosity may require a longer aspiration dwell time.

m In the ‘Filter Type’ field, enter the filter type.

n Select Use Filter Changer if a filter changer is installed.

0 In the ‘Cycles Per Filter’ field, enter the cycles per filter. This
value controls the number of times each filter is used before
it is discarded.

The number of filters to be replaced at each time point is defined by the number
in the ‘Probes’ box on the Method > Tester > Temperature page beneath
‘AutoTemp’. Ensure this number reflects the desired amount of vessel positions.
If ‘AutoTemp’ is disabled, it may be necessary to temporarily enable it to adjust
the number accordingly.

10 Set up standards selection
a  On the left of the window, double-click Standards.

Select Capsule Blank to prevent blank correction on
standard solutions.

¢ On the left of the window, click Standards Selection.

Select Read Blanks Online to read a blank sample at each
time point.

e Select Read Standards Online to read a standard solution at
each time point.

f  Select Calibrate Using Online Standards to read the
standards and use the readings in the calculations.
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Leave this option unselected if using a single offline standard value or a multi-
standard calibration file.

g Select Read Post Cycle Standard to read a standard after the
samples have been analyzed at each time point.

h Select Use Running Mean or Bridged Mean to use multiple
standard readings to calculate %Dissolved and mg Diss.

‘Bridged Mean’ is enabled only if ‘Read Post Cycle Standard’ is selected. Bridged
mean uses the average of the two standards analyzed at each time point.
‘Running Mean uses the average of all standards measured to this point.

i In the ‘Active Component’ field, enter the component name.

j  Inthe ‘Label Content’ field, enter the amount (in milligrams)
of drug product.

11 Set up standards information
a On the left of the window, click Standards Information.
b Select Check Standard if a secondary standard is prepared.

Measurement of the Check Standard is not possible using UV Dissolution if
‘Read Standards Online’ is unselected on the ‘Standards Selection’ page.
Alternatively, you may use Simple Reads, Advanced Reads, or Scan to measure a
Check Standard.

¢ In the ‘Std Weight’ field, enter the standard weight (in
milligrams).

d In the ‘Std Volume’ field, enter the standard volume (in
milliliters).

e If applicable, enter the standard dilution in the ‘Std Dilution’
field.

f In the ‘Std Medium’ field, enter the standard medium.
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g In the ‘Standard Tolerance’ box, enter an appropriate
‘%Variance’ value.

This option is enabled only if measuring a check standard.

Configure ‘Standards Information Media 2 if a media change is required.

12 Set up standard calibration

‘Standard Calibration’ is unavailable if ‘Calibrate Using Online Standards’ is
selected under ‘Standards Selection’.

a Click Standard Calibration to use an offline standard value
or multi-standard calibration file.

b Select Single Standard if the absorbance is manually
entered. Enter the absorbance reading of the reference
standard for the active substance when it is 100% dissolved.

¢ Select Multi-standard if the linearity curve is required to
perform a UV Dissolution run. Click Browse to select a multi-
standard calibration file. The calibration file is stored with
the concentration method (*.mcn).

Configure ‘Standard Calibration Media 2’ if a media change is required.

13 Set up control limits
a Click Control limits.
b Select Use Limits if standard control limits are required.
¢ Enter a value for the % difference in the ‘Difference’ field.
14 Set up spectrophotometer cell match

a  On the left of the window, double-click Spectrophotometer.
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b Click Cell Match.

¢ Select Use Cell Match Limits if cell match limits are
required.

d If ‘Use Cell Match Limits’ is selected, enter the absorbance
units in the ‘A.U.’ field.

Set up spectrophotometer pre-test
a  On the left of the window, click Pre-Test.

b Select Do Pre-Test Scan to find the best wavelength for a
given standard.

¢ Enter an appropriate wavelength (in nanometers) in the
‘Scan From'’ field.

d Enter an appropriate wavelength (in nanometers) in the
‘Scan To’ field.

e Enter the average time (in seconds) in the ‘Ave. (averaging)
Time’ field. Ave. Time corresponds to the number of flashes
for which the spectrophotometer averages the collected
signal. The longer the average time, the longer the signal is
averaged, resulting in one data point. Increasing the average
time results in a smoother scan. If the samples are highly
absorbing or turbid, use a longer average time to improve
accuracy by reducing the noise in the data.

f Enter an appropriate interval (in nanometers) in the
‘Interval’ field. Interval corresponds to how often scanning
occurs between the wavelength entered in the ‘Scan From’
and ‘Scan To’ fields.

Set up analysis (three options)

Single reading
On the left of the window, click Analysis.

Select Single Reading to perform an analysis at a fixed
wavelength.

¢ Enter an appropriate wavelength (in nanometers) in the
‘Wavelength’ field.

Cary WinUV Software Manual



How To...

d Enter an average time (in seconds) in the ‘Average Time’
field. Use Ave. Time to set the signal averaging time to be
used during data collection. If your samples are highly
absorbing or turbid, use a longer average time to improve
accuracy by reducing the noise in your data.

OR Scan
a On the left of the window, click Analysis.
b Select Scan to perform a scan of the solution.

¢ Select Mean or Second derivative for an operation. If
‘Second Derivative’ is selected, enter an appropriate wavelength
(in nanometers) in the ‘Wavelength’ field.

d Enter an appropriate wavelength (in nanometers) in the
‘Scan From’ field.

e Enter an appropriate wavelength (in nanometers) in the
‘Scan To’ field.

f Enter the average time (in seconds) in the ‘Ave. (averaging)
Time’ field.

g Enter an appropriate interval (in nanometers) in the
‘Interval’ field.

OR Single and scan
a Click Analysis.

b Select Single and Scan to perform an analysis at a fixed
wavelength and to scan the solution.

¢ Enter an appropriate wavelength (in nanometers) in the
‘Wavelength’ field.

d Enter the averaging time (in seconds) in the ‘Ave. Time’ field.

e Enter an appropriate wavelength (in nanometers) in the
‘Scan From’ field.

f Enter an appropriate wavelength (in nanometers) in the
‘Scan To’ field.

g Enter the averaging time (in seconds) in the ‘Ave. Time’ field.
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h Enter an appropriate interval (in nanometers) in the
‘Interval’ field.

Configure ‘Analysis media 2" if a media change is required.

17 Set up correction (two options)

Single reading
Click Correction.

Select Do Correction to correct the reading at the analytical
wavelength.

¢ Select Single Reading.

Enter the appropriate wavelength (in nanometers) in the
‘Wavelength’ field.

e Enter the averaging time (in seconds) in the ‘Ave. Time’ field.
OR Correction scan
a On the left of the window, click Correction.

b Select Do Correction to correct the reading at the analytical
wavelength.

¢ Select Scan.

d Enter an appropriate wavelength (in nanometers) in the
‘Scan From'’ field.

e Enter an appropriate wavelength (in nanometers) in the
‘Scan To’ field.

f Enter the averaging time (in seconds) in the ‘Ave. Time’ field.

g Enter an appropriate interval (in nanometers) in the
‘Interval’ field.

Configure ‘Correction Media 2’ if wavelength correction and a media change is
required.
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18 Set sample limits
a  On the left of the window, click Sample Limits.
b Select Use Limits to incorporate limits for the sample time
points.

To remove any of the time points, clear the check box.

To reinstate all of the time points click All.
¢ Enter the Low (%Diss) and High (%Diss) for each time point.
d Click Default Table to reset the %Diss values.
19 Set report print options

a On the left of the window, double-click Reports, then click
Print Options.

b Select AutoPrint to print a report automatically after data
collection.

¢ Select User Data Form to enter extra information about the
traces in the graph box.

d Select Company Logo to include your company's logo in the
report.

e Select Parameters to include method setup parameters in
your report.

f  Select System Configuration to include the settings and
configuration of your system (including your
spectrophotometer, pumps, vessels and testers) in your
report.

g Select Test Log to include a copy of the test log in your
report.

h Select the ‘Graph Type’ to include any of the graphs in the
respective report.

Adjust the X and Y scales to change the size of the graphs that appear on the
report. The default setting is X=40, Y=20. An alternate size may affect the
headings of certain graphs.
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20

Set up report data

a
b

On the left of the window, click Data.

Select Absorbance to print the absorbance data for each
vessel for each time point specified in the Dissolution run. No
calculations are performed on this data. Enter the number of
decimal places to be displayed in the report in the ‘Decimal
Places’ field.

Select ‘Uncorrected’, ‘Cell Match Corrected’, or ‘Cell Match
and Blank Corrected’ under ‘Absorbance Report Options’.

This option affects only the displayed data. All calculations are performed using
fully corrected values.
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Select mg Diss to print the calculated mg dissolved value for
each vessel at each time point specified. Enter the number of
decimal places to be displayed in the report in the ‘Decimal
Places’ field.

Select %Dissolved to print the %Dissolved value achieved at
each specified time point for each vessel. Enter the number
of decimal places to be displayed in the report in the
‘Decimal Places’ field.

Select Time to %Dissolved to print the time at which the
specified % dissolved value is achieved for each vessel during
the run. Enter the number of decimal places to be displayed
in the report in the ‘Decimal Places’ field.

Select Temp/Stir Profile to include the bath temperature, in
degrees Celsius, and stir rate, in revolutions per minute, for
each time point specified. Enter the number of decimal
places to be displayed in the report in the ‘Decimal Places’
field.

Select Statistics to print the calculated mean of all the
standard absorbance readings during the run, as well as
statistical data on these readings. This function includes Abs,
Time, %Diss and mg Diss statistics if these options are
requested for the report.
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The statistics that are reported include: mean value (Mean),
the minimum (Min.) and maximum (Max.) standard
absorbance reading, as well as the Standard Deviation (SD)
and percentage Relative Standard Deviation (%RSD) for
every time point.

i  If ‘Statistics’ is selected, you can enter the number of decimal
places to be displayed in the report for the SD and %RSD
options.

j  Select the vessels you want to include in the report.
21 Set up report time points

a  On the left of the window, click Time Points.

b Select All if all time points are to be reported.

¢ The ‘Time Points’ table displays by default the time points of
your data collection, corresponding to the collect timing
designated in ‘Sampling Time’ points. Select individual time
points by selecting the box next to them.

22 Set up report %Dissolution points
a  On the left of the window, click Dissolution Points.

Select All if all %dissolution points are to be reported. If not
all of the %dissolution points are required, clear the
unnecessary %dissolution points. The maximum number of %
Dissolved points you can enter for report purposes is 20.

23 Set up graph display
a On the left of the window, click Graph Display

b For each section, select Auto Scale Y Min and Auto Scale Y
Max to autoscale the graph(s). Otherwise, enter a value for
each field to define the graph axes.
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Perform a UV Fiber Optic Dissolution run (Cary 50)

This procedure describes how to perform a UV Fiber Optic
Dissolution Run using a Cary 50.

1 Configure the instrument

a
b

In UV Fiber Optic Dissolution, click Configure.

On the left of the window, expand ‘Instruments
Configuration’ by double-clicking Instruments
Configuration.

Enter details for the instrument and any accessories to be
used in your experiment. Click OK.

If you have already performed a UV Fiber Optic Dissolution run, the settings for
these fields will be stored in the pre-saved method or data file.

2 Set up method parameters

Click ‘Connect’ if the system is not online.
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Click Setup to display the ‘Method Setup’ dialog box and
create a new method.

On the left of the window, double-click Method.

Click Method Setup.

Enter a method name in the ‘Method Name’ field.

Choose ‘Single Tester’ or ‘Dual Tester’.

Select Allow Media Change if a media change is required.

Enter the name of the analyst in the ‘Setup By’ field. Verify
the time and date provided.

Enter the name of the reviewer in the ‘Approved By’ field.
Verify the time and date provided.

3 Set up sampling points

On the left of the window, click Sampling Points.
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b Enter the desired time point under ‘Time’.
¢ Enter the desired increment time under ‘Increment Time’.

d Using the up/down arrows, set the number of desired time
points.

e Click Add time point to display the configured point details.

To delete a row, use the up/down arrows under ‘Go To Row’ to select the
appropriate row, and then click ‘Delete Row'.
To clear all sampling points and start over, click ‘Clear Table’.

You can use ‘Increment time’ (enter the time between the time points) and ‘Time
Points’ (enter the number of points that you wish to add). Click ‘Add Cycles’ and
the number of time points entered added and the time between each of the
points will be the time entered in the Increment field.

4 Setup product information
a On the left of the window, double-click Product.
b Click Product Information.
¢ Enter a product name in the ‘Product Name’ field.
d Describe the product being tested in the ‘Notes’ field.

e Under the ‘Sample Label 1’, ‘Sample Label 2’, and ‘Sample
Label 3’ fields, enter company information, department, and
so on, if necessary.

5 Setup media
a  On the left of the window, click Media.

In the ‘Media’ field, enter the type of medium being used for
the UV Fiber Optic Dissolution test. To view previously
entered media, click the drop-down arrow and select the
medium.

¢ In the ‘Media Information’ field, enter any applicable
information regarding the dissolution media.
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d Enter the appropriate information in the ‘Description’ field.
To view previously entered descriptions, click the drop-down
arrow and select the description.

e In the ‘Media Volume’ field, enter the appropriate volume of
media in milliliters. To view previously entered volumes,
click the drop-down arrow and select the volume.

6 Set up media change
a On the left of the window, click Media Change.

The media change parameters page is enabled when ‘Allow Media Change’ is
selected on the ‘Method Setup’ page.
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b  Under the ‘Media Two’ field, enter the second type of media
being used for the dissolution test.

¢ Enter the appropriate information in the ‘Media Information’
and ‘Description’ fields.

d In the ‘Volume Removed’ field, enter the volume removed (in
milliliters).

e Under the ‘Volume Replaced’ field, enter the volume to be
added (in milliliters).

f  Click the Media Change Time point drop-down arrow to
select the time point for the media change.

g Select Automated Media Change if an automated system is
in place to change to the second medium.

7 Set up the dissolution tester spindle
On the left of the window, double-click Tester.
b  Click Spindle.

¢ Click the Apparatus Type drop-down arrow to select an
apparatus type.

d Enter the initial spin rate (in revolutions per minute) in the
‘Initial Spin’ field.

e Enter the initial spin duration (in seconds) in the ‘Initial
Spin Duration’ field.

Cary WinUV Software Manual



How To...

f  Enter the spindle speed (in revolutions per minute) in the
‘Spindle’ field.

g Enter the speed tolerance (in percent) in the ‘Spin Tolerance’
field.

h Enter the speed of the infinity spin (in revolutions per
minute) in the ‘Infinity Spin’ field (unavailable if ‘Allow
Media Change’ is selected under ‘Method Setup’).

i  Enter the spin duration (in minutes) in the ‘Spin Duration’
field.

Configure Spindle Media 2 if a media change is required.

8 Set up temperature
a On the left of the window, double-click Temperature.
b If AutoTemp is installed, select AutoTemp.
¢ Enter the number of probes installed in the ‘Probes’ field.

d Enter the bath temperature (in degrees Celsius) in the ‘Bath
Temperature’ field.

e Enter the vessel temperature (in degrees Celsius) in the
‘Vessel Temperature’ field.

f  Enter the temperature tolerance in the ‘Temperature
Tolerance’ (= °C) field.

g For an extended test, enter the evaporation rate (in
milliliters per minute) in the ‘Evaporation Rate’ field.

h Enter the intervals (in minutes) in the ‘Log Intervals’ field to
report the bath temperature.

9 Set up sampling parameters
a  On the left of the window, click Sampling Parameters.

b Enter the desired ‘Probe return height’ (steps) using the
up/down arrow keys.

¢ Select Resident Probes to keep the probes in the dissolution
media throughout the test.
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The ‘Probe return height’ allows the temperature and optic probes to be raised to
a pre-determined method-specific height during sampling for analysis by the
Fiber Optic Detector.

10 Set up standards selection
a  On the left of the window, double-click Standards.
b Click Standards Selection.

¢ Select ‘Measure Pre-Test Standards’ to read the standard
samples before the test. Select ‘Measure Post-Test Standards’
to read the standard samples after the test.

d Under ‘Standard Tolerance’, enter an appropriate
‘%Variance’ or ‘Abs Difference’ value.

This option is enabled only if measuring pre- and post-test standards.

e Select Bridged Standards to use the average of the pre- and
post-test standards to calculate % and mg dissolved.

f Select Read Post Run Blanks if a blank measurement is
desired at the end of the test.

g Under ‘Blank Tolerance’, enter an appropriate ‘%Variance’ or
‘Abs Difference’ value.

This option is enabled only if measuring post-run blanks.
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h  Enter the component name in the ‘Active Component’ field.

i  Enter the amount of drug product (in milligrams) in the
‘Label Content’ field.

11 Set up standards information
a On the left of the window, click Standards Information.
b Select Check Standard if a secondary standard is prepared.
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¢ Enter the standard weight(s) (in milligrams) in the ‘Std
Weight’ field.

d Enter the standard volume(s) (in milliliters) in the ‘Std
Volume’ field.

e If applicable, enter the standard dilution(s) in the ‘Std
Dilution’ field.

f  Under ‘Standard Tolerance’, enter an appropriate
‘%Variance’ value.

This option is enabled only if measuring check standard.

g Enter the standard media in the ‘Std Media’ field.

Configure Standards Information Media 2 if a media change is required.

12 Set up standard calibration

‘Standard Calibration’ is unavailable if ‘Measure Pre-Test Standards’ is selected
under ‘Standards Selection’.

a  On the left of the window, click Standard Calibration to use
offline standards.

b Select Single Standard if the absorbance is manually
entered. For each vessel, enter the absorbance reading of the
reference standard for the active substance when it is 100%
dissolved.

¢ Select Multi-Standard if the linearity curve is required to
perform a dissolution run. Click Browse to select a multi-
standard calibration file. The calibration file is stored with
the concentration method (*.mcn) or as a batch file (*.bcn).
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Configure ‘Standard Calibration Media 2’ if a media change is required.

13 Set up spectrophotometer cell match
a  On the left of the window, double-click Spectrophotometer.
b Click Cell Match.

¢ Select Use Cell Match Limits if cell match limits are
required.

d If ‘Use Cell Match Limits’ is selected, enter the absorbance
units in the ‘A.U.’ field.

Unlike flow cells, the fiber optic tips that define the pathlength are not machine-
made. Therefore, cell match is for information only when using fiber optic probes
and tips. For this reason, individual probes are baselined and standardized.

14 Set up spectrophotometer pre-test
a  On the left of the window, click Pre-test.

b Select Do Pre-test Scan to find the best wavelength for a
given standard.

¢ Enter an appropriate wavelength (in nanometers) in the
‘Scan From’ field.

d Enter an appropriate wavelength (in nanometers) in the
‘Scan To’ field.

e Enter the averaging time (in seconds) in the Ave. Time field.
Ave. Time corresponds to the number of flashes for which the
spectrophotometer averages the collected signal. The longer
the averaging time, the longer the signal is averaged,
resulting in one data point. Increasing the averaging time
results in a smoother scan. If the samples are highly
absorbing or turbid, use a longer averaging time to improve
accuracy by reducing the noise in the data.
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f Enter an appropriate interval (in nanometers) in the
‘Interval’ field. Interval corresponds to how often scanning
occurs between the wavelength entered in the ‘Scan From’
and ‘Scan To’ fields. For example, if the data was collected
between 200 and 300 nanometers and the interval is set to 1,
the data would be collected every 1 nanometer.

The upper limit of the interval is 5 nanometers.

15 Set up analysis (three options)

Single reading
a  On the left of the window, click Analysis.

b Select Single Reading to perform an analysis at a fixed
wavelength.

¢ Enter an appropriate wavelength (in nanometers) in the
‘Wavelength’ field.

d Enter an averaging time (in seconds) in the ‘Ave. Time’ field.
Use Ave. Time to set the signal averaging time to be used
during data collection. If your samples are highly absorbing
or turbid, use a longer average time to improve accuracy by
reducing the noise in your data.

OR Scan
a Click Analysis.
b  Select Scan to perform a scan of the solution.

¢ Select ‘Mean’ or ‘Second Derivative’ for an operation. If
‘Second Derivative’ is selected, enter an appropriate wavelength
(in nanometers) in the ‘Wavelength’ field.

d Enter an appropriate wavelength (in nanometers) in the
‘Scan From’ field.

e Enter an appropriate wavelength (in nanometers) in the
‘Scan To’ field.

f  Enter the averaging time (in seconds) in the ‘Ave. Time’ field.
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g Enter an appropriate interval (in nanometers) in the
‘Interval’ field.

OR Single and scan
a Click Analysis.

b Select Single and Scan to perform an analysis at a fixed
wavelength and to scan the solution.

¢ Enter an appropriate wavelength (in nanometers) in the
‘Wavelength’ field.

d Enter the averaging time (in seconds) in the ‘Ave. Time’ field.

e Enter an appropriate wavelength (in nanometers) in the
‘Scan From’ field.

f  Enter an appropriate wavelength (in nanometers) in the
‘Scan To’ field.

g Enter the averaging time (in seconds) in the ‘Ave. Time’ field.
h  Enter an appropriate interval (in nanometers) in the

‘Interval’ field.

Configure ‘Correction Media 2" if wavelength correction and a media change is
required.

16 Set up correction (two options)
Single reading
On the left of the window, click Correction.

Select Do Correction to correct the reading at the analytical
wavelength.

¢ Select Single Reading.

Enter the appropriate wavelength (in nanometers) in the
‘Wavelength’ field.

OR Scan

a Click Correction.
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b Select Do Correction to correct the reading at the analytical
wavelength.

¢ Select Scan.

d Enter an appropriate wavelength (in nanometers) in the
‘Scan From’ field.

e Enter an appropriate wavelength (in nanometers) in the
‘Scan To’ field.

f  Enter the averaging time (in seconds) in the ‘Ave. Time’ field.
g Enter an appropriate interval (in nanometers) in the

‘Interval’ field.

The mean of all absorbance values within the scan range will be used with the
Scan option.

Configure ‘Correction Media 2’ if wavelength correction and a media change is
required.

17 Sample limits
a On the left of the window, click Sample Limits.

Select Use Limits to incorporate limits for the sample time
points.

¢ By default all time points are selected. Clear the check box
for each required time point.

d Enter the Low (%Diss) and High (%Diss) for each time point.
To clear the %Diss values, click Default Table.
18 Set up report print options

a On the left of the window, double-click Reports.

b Click Print Options.

¢ Select AutoPrint to print a report automatically after data
collection.
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Select User Data Form to enter extra information about the
traces in the graph box.

Select Company Logo to include your company's logo in the
report.

Select Parameters to include method setup parameters
within your report.

Select System Configuration to include the settings and
configuration of your system (including your
spectrophotometer, pumps, vessels and testers) in your
report.

Select Test Log to include a copy of the test log in your
report.

Select the ‘Graph Type’ to include any of the respective
graphs in the report.

Adjust the X and Y scales to change the size of the graphs that appear on the
report. The default setting is X=40, Y=20. An alternate size may affect the
headings of certain graphs.

19 Set up report data

On the left of the window, click Data.

Select Absorbance to print the absorbance data for each
vessel for each time point specified in the dissolution run. No
calculations are performed on this data. Enter the number of
decimal places to be displayed in the report in the ‘Decimal
Places’ field.

Select ‘Uncorrected’ or ‘Blank Corrected’ under ‘Absorbance
Report Options’.

This option affects only the displayed data. All calculations are performed using
fully corrected values.
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d Select mg Diss to print the calculated mg dissolved value for
each vessel at each time point specified. Enter the number of
decimal places to be displayed in the report in the ‘Decimal
Places’ field.

e Select %Dissolved to print the % dissolved value achieved at
each specified time point for each vessel. Enter the number
of decimal places to be displayed in the report in the
‘Decimal Places’ field.

f  Select Time to %Dissolved to print the time at which the
specified % dissolved value is achieved for each vessel during
the run. Enter the number of decimal places to be displayed
in the report in the ‘Decimal Places’ field.

g Select Temp/Stir Profile to include the bath temperature (in
degrees Celsius) and stir rate (in revolutions per minute), for
each specified time point. Enter the number of decimal
places to be displayed in the report in the ‘Decimal Places’
field.

h Select Statistics to print the calculated mean of all the
standard absorbance readings during the run, as well as
statistical data on these readings. This function includes Abs,
Time, %Diss and mg Diss statistics if these options are
requested for the report.

The statistics that are reported include: mean value (Mean),
the minimum (Min.) and maximum (Max.) standard
absorbance reading, as well as the Standard Deviation (SD)
and percentage Relative Standard Deviation (%RSD) for
every time point.

i  If Statistics is selected, you can enter the number of decimal
places to be displayed in the report for the ‘SD’ and ‘%RSD’
options.

j  Select the vessels you want to include in the report.
20 Set up report time points
a On the left of the window, click Time Points.

b Select All if all time points are to be reported.
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The ‘Time Points’ table displays by default the time points of
your data collection, corresponding to the collect timing
designated in Sampling Time points. Select individual time
points by selecting the box next to them.

21 Set up report %Dissolution points

On the left of the window, click Dissolution Points.

Select All if all %dissolution points are to be reported. If not
all of the %dissolution points are required, clear the
unnecessary %dissolution point ticks. The maximum number
of % Dissolved points you can enter for report purposes is 20.

22 Set up graph display

On the left of the window, click Graph Display.

For each section, select Auto Scale Y Min and Auto Scale Y
Max to autoscale the graph(s). Otherwise, enter a value for
each field to define the graph axes.

Set up tests for validation

The Validate application enables you to carry out a number of
performance tests to verify that the system is performing according
to specification. This procedure describes how to set up your
instrument to perform a validation test.

1 Set up test parameters

In the Validate application, click the Tests menu or the Tests
button to display the ‘Configure’ page.

Select the type of instrument performance tests that you
require. The various tests that are available will be displayed
as tabs across the top of this dialog box.

If your access privileges are restricted by the GLP application, you may find that
fields and buttons in this dialog box are not accessible.
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Click each tab and select the tests you require to be
performed.

Cary WinUV Software Manual



How To...

d For each test, change any parameters that you require to be
changed to suit your laboratory.

If you wish to save the tests you have set up for future use, choose ‘Save
Method As’ from the ‘File’ menu to display the ‘Save As’ dialog box and save the
method (with the file name extension "*.mvo’).

2 Set up automated runs

If you are using either the Multicell Holder or the Auto Double
Aperture accessory to automate the testing procedure:

a Click Setup to display the ‘Setup’ dialog box.
b Click the Analyze tab.

¢ Select the appropriate accessory.

Check with your local Agilent office regarding the availability of this accessory.

3 Start the run

a Click the Start button or click Start on the Commands menu
to commence the testing procedure.

b If you set up for an automated run with the Multicell Holder
in the previous step, then the ‘Cell Loading Guide’ will be
displayed. Place the specified solutions and/or filters exactly
as shown in this dialog box and click OK.

Alternatively, follow the instructions on the prompts that
appear and click OK to continue with the performance tests.

Click Cancel at any time to stop the Validate run.
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For manual runs (without the use of automated accessories), the Validate
application will automatically arrange the tests so that tests requiring your
intervention (for example, placing filters or solutions into the sample
compartment) are performed early in the Validate run. Tests that do not require
your intervention will be performed later in the run. The system will advise you
when you are no longer required. However, if you require, you can change the
order of the tests.

The results for each test are displayed in the Report area
immediately after the test is completed.

4 After the run

At the end of the Validate run, the Cary system automatically
generates a report file. The report file is stored in the Cary WinUV
directory.

The Report file will be saved with the following format:
DATE TIME.RVO

For example:

16 Apr 97 3;57;48 PM.RVO

The date and time will be displayed in the same form that is set in
the Windows Regional Settings Properties dialog box, accessed from
the Windows Control Panel.

At the end of the Validate run, you can also save your data. To do this, choose
‘Save Data As’ from the ‘File’ menu to display the ‘Save As’ dialog box and save
the current method, data and report in a batch file (BVO).
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Poor display of videos and photographs 155

GLP log does not list some privilege changes 156
Report header and footer not being updated 156

To troubleshoot installation and startup problems, check the
information in this chapter. If you still have not found a solution to
your problem, check the ‘Troubleshooting’ section in the hardware
manual supplied with the instrument.

If you are having problems with your software, check the information
in this chapter to see if there is a solution to your problem. You may
also find a solution to your problem in the:

=  ‘Troubleshooting’ section of the Help. To view this, click the
Windows ‘Start’ button, then ‘(All) Programs’, ‘Cary WinUV’, and
‘Cary Help’. Click ‘Troubleshooting’ and follow the links.

= Late Breaking News documents that were shipped with the Cary
WinUYV software.

If you still have not found the solution to your problem, contact your
local Agilent office or representative.
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Instrument offline

Problem

When I start the Cary WinUV software, the application reports that
the instrument is ‘Offline’.

Solutions

=  Check the connection of the main instrument cable (IEEE cable)
attaching the computer to the instrument.

= Ensure the instrument has completed its initialization tests
before you start the Cary WinUV software.

= Contact your local Agilent office.

For more information, refer to Chapter 4 in the Hardware manual
provided with the instrument.

Connect button instead of Start

154

Problem

When I start the Cary WinUV application, I want to use the ‘Start’
button but it has changed to a ‘Connect’ button — why?

Solution

When you first start the Cary WinUV software, the System
Information application has control of the instrument while it
initializes. Until the initialization has finished, any other application
that you start will not have control of the instrument; hence the
‘Connect’ button. Wait until the ‘Connect’ button changes to ‘Start’. If
it does not change, check to see if you have any other Cary
applications running. If they are not collecting data, you can just
click the ‘Connect’ button to get control of the instrument.
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Not enough memory
Problem

After installing version 3 of the Cary WinUV software, I get an error
saying that there is not enough memory and the Cary WinUV
software will not run.

Solution

Check that you have version 4.0 or later of Microsoft Internet
Explorer installed. (To check the version, start Internet Explorer and
choose ‘About Internet Explorer’ from the ‘Help’ menu. The version
number will be displayed).

Poor display of videos and photographs
Problem

The graphics and video display appears fuzzy, grainy or in weird
colors.

Solution
Increase your display settings to a higher resolution.

To do this:

1 Click the Windows Start button then (Settings), Control Panel
and double-click Display.

2  Click the Settings tab and adjust the color quality and screen
resolution to a higher setting (that is, 16 bit or 32 bit color),
providing your monitor and display adapter allow it.

3 Click OK.

You may have to restart your computer for the settings to take effect.
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GLP log does not list some privilege changes

Problem

I have changed multiple privileges using the GLP application, but not
all of them appear in the log file that the application creates. What
has happened?

Solution

You need to click the ‘Apply changes now’ button on the ‘Privileges’
page each time you change privileges for a user or application. You
cannot make multiple changes and then click the ‘Apply Changes
now’ button — the changes are actually made but they don’t appear in
the log.

Report header and footer not being updated

Problem

I have changed the report header and footer information in the
System Information application, but it is not being updated when I
generate a report — why?

Solution

You need to be logged on as an Administrator to make the changes in
System Information.
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